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Intended Readers
This guide is intended for use by qualified personnel in charge of setting up and starting

NovaScale 5xx5/6xx5 Servers for the first time.

Chapter  1. Delivery
describes server features and explains delivery unpacking and inspection procedures.

Chapter 2. Setup Procedure
explains the procedures required to set up and start the server for the first time.

Appendix A. Specifications

Appendix B. Conversion Tables

Highlighting, Abbreviations and Acronyms
The following highlighting conventions are used in this guide:

Bold Identifies predefined commands, subroutines, keywords, files,
structures, buttons, labels, and icons.

Italics Identifies referenced publications, chapters, sections, figures,
and tables.

<         > Identifies parameters to be supplied by the user.

Abbreviations, acronyms and concepts are documented in the Glossary.
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Related Publications
Site Preparation Guide, 86 A1 87EF 
explains how to prepare a Data Processing Center for Bull NovaScale Servers, in
compliance with the standards in force. This guide is intended for use by all personnel
and trade representatives involved in the site preparation process.

User’s Guide, 86 A1 41EM
explains how to use NovaScale 5xx5/6xx5 Servers. This guide is intended for use by
Customer Administrators and Operators.

Maintenance and Service Guide, 86 A7 42EM
explains how to maintain, service, and upgrade NovaScale 5xx5/6xx5 Servers. This
guide is intended for use by qualified support personnel.

Troubleshooting Guide, 86 A7 91EF
explains how to diagnose and solve any problems occurring during Bull NovaScale
Server operation. This guide is intended for use by qualified support personnel.

NovaScale 5000/6000 Series PAM Help Message Guide, 86 A7 32ER
provides the complete collection of PAM Help Messages containing valuable
troubleshooting information. This guide is intended for use by qualified support
personnel.

NovaScale 5000/6000 Series Praxidiag Diagnostics Guide, 86 A7 33ER
provides the complete collection solutions to known problems extracted from the
Praxidiag database. This guide is intended for use by qualified support personnel.

NovaScale 5000/6000 Series Cabling Guide, 86 A1 34ER
describes server cabling.

Bull 1300H/L & 1100H/L Cabinets, 86 A1 91EM
explains how to install and fit out rack cabinets for Bull NovaScale Servers and peripheral
devices.

Documentation Overview, 86 A2 27EM
describes the hardware, software and online documentation available for Bull NovaScale
Servers, related Operating Systems, and licensed programs.

 Note:
According to server configuration and version, certain features and functions described in
this guide may not be accessible. Please contact your Bull Sales Representative for sales
information.
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Regulatory Specifications and Disclaimers

Declaration of the Manufacturer or Importer
We hereby certify that this product is in compliance with European Union EMC Directive
89/336/EEC, using standards EN55022 (Class A) and EN55024 and Low Voltage Directive
73/23/EEC, using standard EN60950. The product has been marked with the CE Mark to
illustrate its compliance.

Safety Compliance Statement
• UL 60950 (USA)
• IEC 60950 (International)
• CSA 60950 (Canada)

European Community (EC) Council Directives
This product is in conformity with the protection requirements of the following EC Council
Directives:

Electromagnetic Compatibility

• 89/336/EEC

Low Voltage

• 73/23/EEC

EC Conformity

• 93/68/EEC

Telecommunications Terminal Equipment

• 1999/5/EC

Neither the provider nor the manufacturer can accept responsibility for any failure to satisfy
the protection requirements resulting from a non-recommended modification of the product.

Compliance with these directives requires:

• an EC declaration of conformity from the manufacturer

• an EC label on the product

• technical documentation
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Federal Communications Commission (FCC) Statement

 Note:
This equipment has been tested and found to comply with the limits for a Class A digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference when the equipment is operated in a
commercial environment. This equipment generates, uses, and can radiate radio frequency
energy and, if not installed and used in accordance with the instruction manual, may cause
harmful interference to radio communications. Operation of this equipment in a residential
area is likely to cause harmful interference in which case the user will be required to correct
the interference at his own expense.

Properly shielded and grounded cables and connectors must be used in order to meet FCC
emission limits. Neither the provider nor the manufacturer are responsible for any radio or
television interference caused by using other than recommended cables and connectors or
by unauthorized changes or modifications to this equipment. Unauthorized changes or
modifications could void the user’s authority to operate the equipment.

Any changes or modifications not expressly approved by the grantee of this device could
void the user’s authority to operate the equipment. The customer is responsible for ensuring
compliance of the modified product.

FCC Declaration of Conformity
This device complies with Part 15 of the FCC Rules. Operation is subject to the following
two conditions: (1) this device may not cause harmful interference, and (2) this device must
accept any interference received, including interference that may cause undesired
operation.

Canadian Compliance Statement (Industry Canada)
This Class A digital apparatus meets all requirements of the Canadian Interference Causing
Equipment Regulations.

Cet appareil numérique de la classe A est conforme à la norme NMB–003 du Canada.

This product is in conformity with the protection requirements of the following standards:

Electromagnetic Compatibility

• ICES–003
• NMB–003

Laser Compliance Notice
This product that uses laser technology complies with Class 1 laser requirements.

A CLASS 1 LASER PRODUCT label is located on the laser device.

Class 1 Laser Product

Luokan 1 Laserlaite

Klasse 1 Laser Apparat

Laser Klasse 1
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Definition of Safety Notices

 DANGER
A Danger notice indicates the presence of a hazard that has the potential of causing
death or serious personal injury.

 CAUTION:
A Caution notice indicates the presence of a hazard that has the potential of causing
moderate or minor personal injury.

 Warning: 
A Warning notice indicates an action that could cause damage to a program, device,
system, or data.

Electrical Safety
The following safety instructions shall be observed when connecting or disconnecting
devices to the system.

 DANGER
The Customer is responsible for ensuring that the AC electricity supply is compliant
with national and local recommendations, regulations, standards and codes of
practice.
An incorrectly wired and grounded electrical outlet may place hazardous voltage on
metal parts of the system or the devices that attach to the system and result in an
electrical shock.
It is mandatory to remove power cables from electrical outlets before relocating the
system.

 CAUTION:
This unit has more than one power supply cable. Follow procedures for removal of
power from the system when directed.
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Laser Safety Information
The optical drive in this system unit is classified as a Class 1 level Laser product. The
optical drive has a label that identifies its classification.

The optical drive in this system unit is certified in the U.S. to conform to the requirements of
the Department of Health and Human Services 21 Code of Federal Regulations (DHHS 21
CFR) Subchapter J for Class 1 laser products. Elsewhere, the drive is certified to conform to
the requirements of the International Electrotechnical Commission (IEC) 60825–1: 2001 and
CENELEC EN 60825–1: 1994 for Class 1 laser products.

 CAUTION:
Invisible laser radiation when open. Do not stare into beam or view directly with
optical instruments.

Class 1 Laser products are not considered to be hazardous. The optical drive contains
internally a Class 3B gallium–arsenide laser that is nominally 30 milliwatts at 830
nanometers. The design incorporates a combination of enclosures, electronics, and
redundant interlocks such that there is no exposure to laser radiation above a Class 1 level
during normal operation, user maintenance, or servicing conditions.

Data Integrity and Verification

 Warning: 
Bull NovaScale Servers are designed to reduce the risk of undetected data corruption
or loss. However, if unplanned outages or system failures occur, users are strongly
advised to check the accuracy of the operations performed and the data saved or
transmitted by the system at the time of outage or failure.
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Environmental Standards

Climatic and Atmospheric Specifications
The servers comply with standards:

• IEC 60068.2.1
IEC 60068.2.2
IEC 60068.2.78
IEC 60529
IEC 60950
ISO 7779

Electrical Specifications
The servers comply with standards:

• IEC 60038
IEC 60059
IEC 60196
IEC 60364
IEC 61689

Mains Source Power

• 207–244 VAC, 49 – 61 Hz (single phase Ph / N + PE or Ph / Ph + PE), 
20/32/64A per PDU (see model specifications)

Voltage Sag

• 20 ms (IEC 1000–4–11)

Electromagnetic Compatibility

The servers comply with standards:

Europe: EMC Directive, 89/336/EEC

• EN55022, Class A Limit, Radiated & Conducted Emissions
• EN55024, ITE Specific Immunity Standard
• EN61000–4–2, ESD Immunity (Level 2 Contact Discharge, Level 3 Air Dis-

charge)
• EN61000–4–3, Radiated Immunity (Level 2)
• EN61000–4–4, Electrical Fast Transient (Level 2)
• EN61000–4–5, AC Surge
• EN61000–4–6, Conducted RF
• EN61000–4–8, Power Frequency Magnetic Fields
• EN61000–4–11, Voltage Dips and Interrupts
• EN61000–3–2, Limit for Harmonic Current Emissions
• EN61000–3–3, Voltage Flicker

North America • FCC Part 15 Class A
• ICES–003 Issue 3 Class A

Bull NovaScale Blade servers also comply with standards:

• Japan: IEC 1000–3–2

• Australia / New Zealand: IEC 60950

• Taiwan: BSMI Approval

• Korea: RRL Approval

• Russia: GOST Approved

• International: CISPR, Class A Limit
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Protection against Electrostatic Discharges
CMOS (Complementary Metal Oxide Semiconductor) technology is highly sensitive to
electrostatic discharges. The use of conductive antistatic flooring is strongly recommended.

Maintenance personnel must wear wrist–straps before handling electronic equipment.
A ground socket is provided in each cabinet.

Shocks and Vibrations
The servers comply with standards:

IEC 60068–1
IEC 60068–2–6
IEC 60068–2–27
IEC 60068–2–31
IEC 60068–2–47
IEC 60068–2–64
IEC 60050
ISO 2041
ISO 5348
ISO 5344
ISO 8626

Operating Mode (on levelers)

• Sinusoidal vibrations:

– Duration: 1 sweep, 1 octave/mn

– 5 – 16 Hz range: 0.25 mm peak

– 16 –200 Hz range: 0.25 g peak

• Random excitation:

– Duration: 15 mn

– Frequency: 5 – 200 Hz

– Spectral density: 1.5x10–4 g�/Hz

– Root mean square acceleration: 0.17g RMS

Non–operating Mode (on castors)

• Sweep sine:

– Duration: 1 sweep, 1 octave/mn

– 5 – 16 Hz range: 0.25 mm peak

– 16 – 200 Hz range: 0.25 g peak

• Random excitation:

– Duration: 15 mn

– Frequency: 5 – 200 Hz

– Spectral density: 1.5x10–3 g�/Hz

– Root mean square acceleration: 0.54g RMS

Shock Tests:

• Duration: 11 ms

• Form: 1/2 sinusoidal

• Amplitude: 15 g
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Pollution Limits
The servers comply with standard:

• NFX44–101, Class 4 000 000

Audio–Noise Limits
The servers comply with standards:

• ISO 7779

• ISO 11201

• ISO 7574

• ISO 4871

• ISO 9295

• ISO 9296

• IEC 61260

• IEC 60651 (Bull NovaScale 5000 Series & Bull NovaScale 6000 Series)

• IEC 61672–1 (Bull NovaScale 4000 Series)

• IEC 61672–2 (Bull NovaScale 4000 Series)

Operating LwAd Acoustical Power

• 7.4 Bel

Operating Lpa Acoustical Pressure

• 60 dBA

Safety Specifications
The servers comply with national and international standards:

• IEC 60950

• EN 60950

• UL 60950

• CAN/CSA C22–2 N° 60950–00
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Installation Flowchart
This flowchart summarizes main installation and setup procedures.

Unpacking the Server

Step OK

• Inspect server packing

• Remove server packing

• Inspect the server

• Unload the server cabinet(s) and accessories

• Store packing items

Installing and Securing the Cabinet

Step OK

• Position the cabinet(s)

• Secure the cabinet(s) into place

• Remove shipping brackets

Inspecting the Server

Step OK

• Check that the server is not damaged and is compliant with the Purchase Order

• Inspect internal components and cabling
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Connecting Inter–Cabinet Cables

Step OK

• Connect server inter–cabinet data cables.

Connecting the Server to the Power Supply

Step OK

• Mount power supply cable sockets

• Connect the server power cables to the dedicated power supply

Powering up the Server

Step OK

• Power on the server to the standby mode

• Launch PAM software

• Check server status

• Power up / down the server domain(s)

• Shut down / restart the server

Completing PAP Unit Configuration and Operating System Setup

Step OK

• Change the PAP unit default name

• Launch the PAP Configuration Setup wizard

• Configure Customer information

• Configure Autocalls

• Connect the PAP unit to the Enterprise LAN

• Complete Operating System setup for the server domain(s)
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Connecting the Server to the Enterprise LAN and Connecting External Devices

Step OK

• Connect the server to the Enterprise LAN

• Connect external peripherals (storage, modem, ...)

Confirming Correct Installation

Step OK

• Test network connections

• Test Autocalls

• Record site data

• Send the Intervention Report
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Chapter 1. Delivery

This chapter explains delivery unpacking and inspection procedures. It includes the

following topics:

• Overview, on page 1-2

• General Recommendations, on page 1-7

• Unpacking the Server Cabinet, on page 1-8

• Inspecting the Server before Unloading the Cabinet, on page 1-8

• Inspecting Internal Components and Cabling, on page 1-11

• Getting to know the Server, on page 1-12
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Bull NovaScale Server Overview
Bull NovaScale Servers for business and scientific applications are based upon the FAME
architecture (Flexible Architecture for Multiple Environments), leveraging the latest
generation of Intel� Itanium� 2 processors.

NovaScale 5xx5 Servers are designed to operate as single SMP systems and are delivered
with one pre–configured domain englobing all the hardware and software resources
managed by the Operating System.

NovaScale 6xx5 Servers are designed to operate as one or two hardware–independent
SMP systems or domains, each running an Operating System instance and a specific set of
applications.

According to version, servers are delivered rack–mounted and ready–to–use in high or low
cabinets.

Figure 1. Bull NovaScale Server cabinets

Dynamic Partitioning
Bull NovaScale 6000 Series servers can be dynamically partitioned into physically
independent ccNUMA (Cache Coherent Non Uniform Memory Access) SMP systems or
domains, each running an Operating System instance and a specific set of applications.

Extended Configurations
Several Bull NovaScale Servers may be administered through a single instance of PAM
software.

Cluster Configurations
Several Bull NovaScale Servers may be grouped to act like a single system, enabling high
availability, load balancing and parallel processing.
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Server Features
The main features of Bull NovaScale Servers are:

Intel� Itanium� Processor Family architecture:

– Modularity, predictable performance and growth

High availability:

– Component redundancy

– Capacity to isolate or replace a faulty component without service disruption

– Global and unified system visibility

– Round–the–clock operation

Scalability:

– Dynamic partitioning

– Power on demand : capacity to dynamically adapt resources to load requirement

Simultaneous support of multiple environments:

– Microsoft� Windows� Server

– Linux�

High performance computing capabilites:

– Technical and scientific applications:

. High Performance Computing (HPC)

– Business Intelligence:

. Datawarehousing

. Datamining

– Large enterprise applications:

. ERP

. CRM

. SCM ...

– Large database applications for Internet transactions.

– Large business sector applications:

. Online billing

. Online reservations

. Online banking ...

Built–in Platform Administration and Maintenance (PAM) software suite:

– Proactive administration

– Optimization of resources

– Automatic generation of corrective actions and calls to support centers

– Dynamic configuration

Bull NovaScale Master System Management (NSM) software suite:

– Windows, Linux, and Platform management

– Monitoring, Information, Control, and Event Handling

– Client / Server / Agent architecture

– WEB standard OpenSource solutions
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Server Hardware

 Note:
Abbreviations and acronyms are documented in the Glossary.

Main server hardware components are:

Central SubSystem Module (CSS Module)
Main server hardware components are housed in the CSS Module. For easy access and
servicing, the CSS Module is composed of three interconnected units:

Front Unit Core Unit Rear Unit

1 or 2 QBBs 1 MQB 1 or 2 IOCs

1 or 2 Internal Peripheral Drawers 1 MIO 1 or 2 IOLs

2 MSXs 1 PMB

1 MFL 2 or 4 DPS Units

8 Fanboxes

 Notes:

• The NovaScale 6xx5 Server CSS Module can be logically divided into two Cells, each
with one QBB and one IOC, to allow dynamic partitioning.

• The NovaScale 6165 Server is equipped with two inter–connected CSS modules.

Front Unit

Quad Brick Block (QBB)

The QBB is equipped with 2 to 4 Itanium[  2 processors and 16 DDR DIMMs. The QBB
communicates with the rest of the system the high–speed bidirectional link Scalability Port
Switches (SPS) located on the MSX.

Internal Peripheral Drawer (IPD)

The Internal Peripheral Drawer is equipped with a DVD/CD ROM drive and a USB port. The
Internal Peripheral Drawer is connected to the MQB in the Core Unit via a Device Interface
Board (DIB). Optionally, the Internal Peripheral Drawer can house 2 SCSI Disks for OS
partitions or storage.

Core Unit

Midplane QBB Board (MQB)

The QBBs and the Internal Peripheral Drawers are connected to the MQB.

Midplane IO Board (MIO)

The IOCs and the PMB are connected to the MIO.

Midplane SPS & XPS Board (MSX)

Each MSX houses 1 high–speed directional link Scalability Port Switch (SPS) and is
connected to both the MIO and the MQB. Each QBB and IOC communicates with the rest of
the system through the SPS.

Midplane Fan & Logistics Board (MFL)

16 Fans and various logistics components are implemented on the MFL. The MFL is
connected to both the MIO and the MQB.

Fanboxes

8 Fanboxes, each housing 2 fans, provide redundant cooling.



1-5Delivery

Rear Unit

IO board Compact (IOC)

The IOC provides 6 x 133 MHz PCI buses for the connection of up to 6 (2 long and 4 short)
PCI–X boards, and a PCI Hot Plug Board (HPB). The IOC communicates with the rest of the
system through the high–speed bidirectional link Scalability Port Switches (SPS) located
on the MSX.

IO board Legacy (IOL)

The IOL is an IOC daughter board providing legacy IO connections: 2 USB ports, 1 LAN
port, 2 serial ports, and 1 video port.

Platform Maintenance Board (PMB)

The PMB concentrates logistics access and links the platform to the Platform Administration
Processor (PAP Unit) running Platform Administration and Maintenance (PAM) software.

Distributed Power Supply (DPS) Unit

Each DPS Unit supplies 48V AC/DC power to the server. The server is equipped with 2 or 4
DPS units for full redundancy.

Platform Administration Processor (PAP) Unit
The PAP Unit hosts all server administration software, in particular Platform Administration
and Maintenance (PAM) software.

KVM Switch
The KVM Switch allows the use of a single keyboard, monitor and mouse for the local
server domains and the local PAM console.

Console
The Console contains the keyboard, monitor and touch pad / mouse used for local access
to the server domains and to the PAP Unit.

Disk Subsystem
If the disk slots in the Internal Peripheral Drawer are not used for OS disk partitions, a SCSI
RAID or FC disk subsystem is required.

Additional Peripherals
Additional peripherals such as disk subsystems, storage area networks, communication
networks, archiving peripherals etc. can be connected to the server via PCI adapters
located in the IOCs. Such peripherals may either be rack–mounted in the server cabinet (if
free space is available) or in external cabinets.

Server Firmware and Software

Operating Systems (OS)

The server is certified for the following Operating Systems:

• Windows Server 2003, Enterprise Edition

• Windows Server 2003, Datacenter Edition

• Linux Red Hat Enterprise Linux Advanced Server

• Novell SUSE
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BIOS

The BIOS controls the server startup process, dynamic resource allocation (Domain
reconfiguration, hot–plugging), and error handling. The BIOS also includes:

• The Extended Firmware Interface (EFI), which provides the OS with system services.

• The EFI Shell, an autonomous environment used to run Off–line Test & Diagnostic
suites.

Platform Administration and Maintenance (PAM) suite

The PAM Web–based software suite is used to operate, monitor, and configure the server.
PAM can be accessed locally or remotely through Microsoft Internet Explorer or Mozilla
browsers, under the protection of appropriate access rights. PAM provides the
administration functions needed to manage and maintain the server:

• Domain configuration and resource allocation

• Alert or maintenance requests to the Customer Service Center

• Error logging …

Test & Diagnostics suites

The server is delivered with the following T & D suites:

• Online Test & Diagnostic suite

• Offline Test & Diagnostic suite

• Power–On Self–Test suite

NovaScale Master (NSM) Management suite

The NSM software suite allows you to monitor and manage NovaScale Windows and Linux
systems.

Conformance to Standards

Intel

Bull NovaScale Servers conform to all Intel platform standards:

• ACPI (Advanced Configuration and Power Interface)

• IPMI (Intelligent Platform Management Interface)

• EFI (Extended Firmware Interface)

• SMBIOS (System Management BIOS)

• DIG64 (Developer Interface Guide for Intel[  Itanium[  Architecture)

Windows

Bull NovaScale Servers conform to the standards set out in the Windows Hardware Design
Guide.
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General Recommendations
Bull NovaScale Servers are delivered rack–mounted and pre–cabled in one or more high or
low cabinets, according to the version chosen.

Site preparation must be completed by the pre–arranged delivery date. Any delay due to
non–completion of the site by the pre–arranged date will be considered as the Customer’s
responsibility.

The server is delivered 24 hours in advance of the scheduled installation date. On arrival, it
must be placed, in its packing, in the Computer Room so that it reaches room temperature
before powering up (optimum operating temperature = 22° C + 3° C, hygrometry = 50% +
5%).

 CAUTION:
It is mandatory for the server to be transported vertically. Servers are extremely
heavy and require the use of an elevator. The Data Processing Site manager must
allocate enough personnel to ensure safe handling.

See Appendix A. for server specifications.

Use the Packing Slip to check the number and condition of the shipping boxes prior to
unpacking.

The server is delivered with a box labeled Open Me First containing all the data and items
required for installation.

 Warning: 
To avoid condensation and incorrect handling, the server must be removed from its
packing by authorized Service personnel ONLY, on the scheduled installation date.
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Unpacking the Server Cabinet
Instructions on how to unpack cabinets for Bull NovaScale Servers and peripheral devices
are set out in document Bull 1300H/L & 1100H/L Cabinets, 86 A1 91EM.

 Warning: 
The server must not be unpacked before it has reached room temperature (24 hours
in the Computer Room).

 DANGER
Server cabinets are extremely heavy. Authorized Service personnel ONLY may
unpack and physically install cabinets. The instructions set out below are to be
strictly complied with to avoid serious personal injury.

Inspecting the Server before Unloading the Cabinet
Once the server cabinet has been unpacked, you must perform a preliminary visual
inspection before unloading the cabinet.

 Note:
Server components and configuration may differ according to the version chosen.

 CAUTION:
If the inspection indicates an unacceptable safety condition, the condition must be
corrected before powering up the server.

1. Check that the server delivered is compliant with the Purchase Order.

2. Check covers and doors for sharp edges, damage or alterations.

3. Check the correct fit of covers and doors.

4. Open the front and rear doors.

 Note:
Unlock the front door with the key, pull the handle forwards and upwards to disengage
the lock.

5. Check for internal damage, alterations and obvious safety hazards such as broken wires,
sharp edges, or broken insulation.

6. Check internal cables for damage.

7. Check for dirt, water, and any other form of contamination inside the cabinet.

8. Check the voltage label on the back of the cabinet to ensure that it matches the voltage
at the power outlet.

9. Check external power cables for damage.

10. Check correct closure of front and rear doors.
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Removing CSS Module Brackets and Installing Stoppers
Each Bull NovaScale Server CSS module is equipped with two yellow shipping brackets at
the front and two yellow shipping brackets at the rear of the cabinet. Once the server has
been installed and correctly secured, you must remove all shipping brackets and install the
stoppers supplied in the Open Me First box.

Removing CSS Module Shipping Brackets
11.From the front of the cabinet, loosen and remove the 2 shipping brackets on either side

of the CSS module / cabinet with the 8 mm hex wrench.

Figure 2. Removing front shipping brackets

12.From the rear of the cabinet, loosen and remove the 2 shipping brackets on either side
of the CSS module / cabinet with the 8 mm hex wrench.

Figure 3. Removing rear shipping brackets.

Repeat Steps 11 and 12 for each CSS module in the cabinet.

  Important: 
Take care to store shipping brackets and fittings with other packing items.
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Installing Stoppers
Four stoppers, complete with captive screws, are supplied with each CSS module and must
be installed once shipping brackets have been removed.

The two narrow stoppers are installed on the front cabinet frame and the two deep stoppers
are installed on the rear cabinet frame.

1. From the front of the cabinet, align the 2 narrow stoppers (A) with the front of the frame
and tighten into place.

Figure 4. Installing front stoppers

2. From the rear of the cabinet, align the 2 deep stoppers (B) with the front of the frame and
tighten into place.

Figure 5. Installing rear stoppers.

Repeat Steps 1 and 2 for each CSS module in the cabinet.
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Inspecting Internal Components and Cabling
A thorough visual inspection of internal components and cabling should now be carried out
before powering up the server.

 CAUTION:
If the inspection indicates an unacceptable safety condition, the condition must be
corrected before powering up the server.

1. Visually check internal cables for damage.

2. Visually check system components for damage.

3. Manually check internal cable connections.

4. Visually check external power cables for damage.

 Note:
If you need to check CSS Module components, refer to the Maintenance and Service Guide.

For guidance with cabling, see NovaScale 5000/6000 Series Cabling Guide, 86 A1 34ER.
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Getting to Know the Server

 Note:
Abbreviations and acronyms are documented in the Glossary.

NovaScale 5085 Server

 Note:
Server components and configuration may differ according to the version chosen.

The server is delivered rack–mounted and pre–cabled in a low or high cabinet, typically
containing the following components:

Front Rear

1 CSS module with core unit, power supply and AC power cable, including: 8 U1

IO Box (IOC) with: 2 IOL board – legacy ports

8 U

IO Box (IOC) with:

3 6xPCI hot plug slots (133Mhz)

Internal Peripheral Drawer with: 4 DVD–ROM driveInternal Peripheral Drawer with:

5 2xInternal SCSI RAID disks

6 USB port

PMB board 7

2 or 4 DPS units  8*

2xQBB subsets (1 to 4 CPUs each) 9

10 Slideaway console with monitor and keyboard 1 U

11 8–ports KVM switch 1 U

12 PAP unit with CD–ROM writer, FDD and 2 disks 2 U

13* 1 or 2 PDU(s) with AC power cable

14 1 optional FC disk 3 U

16 Free space for additional components (SCSI or FC disks) 4 U

* Redundant servers are connected to 2 PDUs and have 4 DPS units.

Figure 6. NovaScale 5085 Server components (19 U cabinet example)
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NovaScale 5165 Server

 Note:
Server components and configuration may differ according to the version chosen.

The server is delivered rack–mounted and pre–cabled in a low or high cabinet, typically
containing the following components:

Front Rear

1,
15

CSS module with core unit, power supply and AC power cable, including: 8 U
x2

1,
15 IO Box (IOC) with: 2 IOL board – legacy ports

8 U
x2IO Box (IOC) with:

3 6xPCI hot plug slots (133Mhz)

Internal Peripheral Drawer with: 4 DVD–ROM driveInternal Peripheral Drawer with:

5 2xInternal SCSI RAID disks

6 USB port

PMB board 7

2 or 4 DPS units  8*

2xQBB subsets (1 to 4 CPUs each) 9

10 Slideaway console with monitor and keyboard 1 U

11 8–ports KVM switch 1 U

12 PAP unit with CD–ROM writer, FDD and 2 disks 2 U

13* 1 or 2 PDU(s) with AC power cable

14 1 optional SCSI disk 2 U

16 Free space for additional components (SCSI or FC disks) 18 U

* Redundant servers are connected to 2 PDUs and have 4 DPS units.

Figure 7. NovaScale 5165 Server components (40U cabinet example)
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NovaScale 6085 Server

 Note:
Server components and configuration may differ according to the version chosen.

The server is delivered rack–mounted and pre–cabled in a low or high cabinet, typically
containing the following components:

XXXXXXXX Front     XXXXXXXXXXXXXXXXXXXX Rear

1 CSS module with core unit, power supply and AC power cable, including: 8 U

2xIO Boxes (IOC) each with: 2 IOL board – legacy ports

3 6xPCI hot plug slots (133Mhz)

2xInternal Peripheral Drawers each with: 4 DVD–ROM drive

5 2xInternal SCSI RAID disks

6 USB port

PMB board 7

2 or 4 DPS units  8*

2xQBB subsets (1 to 4 CPUs each) 9

10 Slideaway console with monitor and keyboard 1 U

11 8–ports KVM switch 1 U

12 PAP unit with CD–ROM writer, FDD and 2 disks 2 U

13* 1 or 2 PDU(s) with AC power cable

14 1 optional FC disk 3 U

16 Free space for additional components 4 U

* Redundant servers are connected to 2 PDUs and have 4 DPS units.

Figure 8. NovaScale 6085 Server components (19 U cabinet example)
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NovaScale 6165 Server

 Note:
Server components and configuration may differ according to the version chosen.

The server is delivered rack–mounted and pre–cabled in a low or high cabinet, typically
containing the following components:

Front Rear

1,
15

CSS module with core unit, power supply and AC power cable, including: 8 U
x2

1,
15 IO Box (IOC) with: 2 IOL board – legacy ports

8 U
x2IO Box (IOC) with:

3 6xPCI hot plug slots (133Mhz)

Internal Peripheral Drawer with: 4 DVD–ROM driveInternal Peripheral Drawer with:

5 2xInternal SCSI RAID disks

6 USB port

PMB board 7

2 or 4 DPS units  8*

2xQBB subsets (1 to 4 CPUs each) 9

10 Slideaway console with monitor and keyboard 1 U

11 8–ports KVM switch 1 U

12 PAP unit with CD–ROM writer, FDD and 2 disks 2 U

13* 1 or 2 PDU(s) with AC power cable

14 2 FC disks 6 U

16 Free space for additional components (SCSI or FC disks) 14 U

* Redundant servers are connected to 2 PDUs and have 4 DPS units.

Figure 9. NovaScale 6165 Server components (40U cabinet example)
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Server Components

 Note:
Server components and configuration may differ according to the version chosen.

Central Subsystem (CSS) Module
The CSS module houses main hardware components:

Front     Rear

Front 1 or 2 QBB (Quad Brick Board) subset(s):
Each QBB subset houses:

• 1 mother board
• 2 memory boards
• 1 to 4 processors
• 16 DIMMs

1 or 2 Internal Peripheral Drawer(s):
Each drawer houses:

• 2 internal SCSI RAID system disks
• 1 DVD–ROM drive
• 1 USB port

Rear 1 or 2 IO Box(es) (Input / Output Board Compact):

Each IO Box can house:

• 1 HPB (PCI Hot Plug Board)

• 6 hot–plug 133 MHz PCI–X slots (2 long, 4 short)

• 1 IOL (Input / Output  board Legacy):

– 2 A–type USB ports

– 1 RJ45 10/100/1000 Mbps Ethernet port

– 2 DB9–M RS232 serial ports
– 1 HD15–F VGA port

1 PMB (Platform Management Board):
This active board links the server to the Platform Administration Processor (PAP) Unit
(via an Ethernet link).

Core 1 Core unit
This set of 5 active boards is used to interconnect the QBBs, IOCs, DIBs and the PMB.

Figure 10. CSS module features (full CSS module example)

 Note:
Abbreviations and acronyms are documented in the Glossary.
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Integrated Platform Administration Processor (PAP) Unit
The PAP unit is linked to the server via the Platform Management Board (PMB). It hosts
Platform Administration Software (PAM). According to version, the PAP unit is located in the
center of a high cabinet or at the top of a low cabinet.

Or

PAP Unit 1U PAP Unit 2U

• 1 P4C / 3 GHz PC

– 1 GB RAM

– 2 x 80 GB SATA disks (RAID1)

– 1 CD/DVD–ROM drive

– 1 1 FDD

– 2 serial ports

– 1 parallel port

– 3 PCI slots

– 2 Gigabit Ethernet ports (1 free)

– 3 USB 2.0 ports (1 front + 2 rear)

– 1 SVGA video port

– 2 PS/2 ports

• 1 P4C / 2.6 GHz PC

– 1 GB RAM

– 2 x 80 GB SATA disks (RAID1)

– 1 free disk slot

– 1 CD/DVD–ROM drive

– 1 FDD

– 2 serial ports

– 1 parallel port

– 3 PCI slots

– 2 Gigabit Ethernet ports (1 free)

– 3 USB 2.0 ports (1 front + 2 rear )

– 1 SVGA video port

– 2 PS/2 ports

• Microsoft Windows operating system

• Internet Explorer software

• PAM software

• 1 power cable

Figure 11. PAP unit



1-18 Installation Guide

Integrated Console
According to version, the console is located in the center of a high cabinet or at the top of a
low cabinet.

The inegrated slideaway Console contains the keyboard, monitor and touch pad used for
local access to the server and to the Platform Administration Processor (PAP) Unit.

• 1 monitor

• 1  QWERTY keyboard and touch pad

• 1 power cable

Figure 12. Slideaway Console features
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Keyboard / Video / Mouse (KVM) Switch
The KVM Switch allows the use of the integrated console for the local server and the local
Platform Administration and Maintenance console.

8–Port KVM Switch

Or

• 8 ports

• 1 power cable

Figure 13. 8–port KVM switch features

16–Port KVM Switch

• 16 ports

• 1 power cable

Figure 14. 16–port KVM switch features
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SR–0812 SCSI RAID / SJ–0812 SCSI JBOD Disk Racks
Optionally, SR–0812 SCSI RAID / SJ–0812 SCSI JBOD Disk Racks are delivered with
pre–installed system disks (two RAID#1 and one spare disk per domain). Empty slots can
be used for data disks. According to version, the Disk Rack is located in the main or I/O
cabinet.

• 8 slots

• 1 RAID controller card

• 2 power cables (redundant power supply)

Figure 15. SR–0812 SCSI RAID / SJ–0812 SCSI JBOD disk rack features

SJ–0812 SCSI JBOD Extension Disk Rack
The SJ–0812 SCSI JBOD Extension Disk Rack offers eight empty slots for Customer data
disks. According to version, the Extension Disk Rack is located in the main or I/O cabinet.

• 8 slots

• 2 power cables (redundant power supply)

Figure 16. SJ–0812 SCSI JBOD extension disk rack features
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FDA 1x00 FC Disk Rack
Optionally, the FDA 1x00 FC Disk Rack is delivered with pre–installed system disks (two
RAID#1 and one spare disk per domain). Empty slots can be used for data disks. According
to version, the Disk Rack is located in the main or I/O cabinet.

• 15 slots

• 2 FC RAID controller cards, 1 FC port per controller

• 3 disks per domain (2 RAID#1 + 1 spare)

• 2 power cables (redundant power supply)

Figure 17. FDA 1x00 FC disk rack features

FDA 2x00 FC Disk Rack
Optionallay, the FDA 2x00 FC Disk Rack is delivered with pre–installed system disks (two
RAID#1 and one spare disk per domain). Empty slots can be used for data disks. According
to version, the Disk Rack is located in the main or I/O cabinet.

• 1 controller unit & 1 disk unit

• 15 slots

• 2 FC RAID controller cards, 2 FC ports per controller

• 3 disks per domain (2 RAID#1 + 1 spare)

• 2 power cables (redundant power supply)

Figure 18. FDA 2x00 FC disk rack features
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FDA 1x00 FC Extension Disk Rack
The FDA 1x00 FC Extension Disk Rack offers15 empty slots for data disks. According to
version, the Disk Rack is located in the main or I/O cabinet.

• 15 slots

• 2 power cables (redundant power supply)

Figure 19. FDA 1x00 FC extension disk rack features
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Ethernet Hub
The optional Maintenance LAN Ethernet Hub is used to connect PMB, PAP Unit and
external FDA FC Disk Rack Ethernet ports.

Ethernet Hub – 8 ports

– 1 power cable

– 1 power bar

Figure 20. Ethernet hub features

USB Modem
The optional USB modem is used to transmit Autocalls to the Remote Maintenance Center,
if the Customer’s maintenance contract includes the Autocall feature.

USB Modem – 1 USB cable

– 1 RJ11 cable

Figure 21. USB modem features

NPort Server
The Nport Server is used connect the administration port of the SR–0812 SCSI RAID disk
rack to the PAP Unit.

NPort Server – 2 DB9 to Jack cable

– 1 RJ45 – RJ45 Ethernet cable

Figure 22. NPort Server features
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Chapter 2. Setup Procedure

  Important: 
Certain features described in this chapter are reserved for partitioned servers and
extended systems and/or to systems connected to a Storage Area Network (SAN).

This chapter  explains the procedures required to set up and start the server for the first
time. It includes the following topics:

• Accessing Server Components, on page 2-2

• Checking PMB Code Wheel Settings, on page 2-4

• Checking Server Cabling, on page 2-4

• Connecting the Server to the Site Power Supply, on page 2-5

• Launching PAM Software, on page 2-7

• Checking Server Status via PAM, on page 2-10

• Toggling the Local / Integrated Console Display, on page 2-13

• Powering Up / Down Server Domains, on page 2-14

• Changing the iStorage Manager User Name and Password, on page 2-26

• Changing the S@N.IT Password, on page 2-27

• Completing PAP Unit Configuration, on page 2-28

• Configuring Customer Information, on page 2-33

• Configuring Autocalls, on page 2-34

• Connecting the PAP Unit to the Customer’s Enterprise LAN, on page 2-36

• Connecting to the PAM Web Site from a Remote Computer/Workstation, on page 2-37

• Enabling Remote Access to iSM on the Client Computer, on page 2-37

• Completing Operating System Setup, on page 2-39

• Connecting the Server to the Enterprise LAN, on page 2-55

• Connecting the USB Modem and External Devices, on page 2-56

• Testing Network Connections, on page 2-57

• Testing Autocalls, on page 2-57

• Completing the PAM Installation Intervention Report, on page 2-57

• Renaming the Central Subsystem, on page 2-58

• Setting up PAP Unit Users, on page 2-67

• Backing Up / Restoring PAM Configuration Data, on page 2-69

 Notes:

For an overall summary of installation and setup procedures, see Installation Flowchart, on
page xx.
If a problem arises during the setup procedure, refer to Troubleshooting Guide, 86 A7 91EF
and NovaScale 5000/6000 Series Praxidiag Diagnostics Guide.
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Accessing Server Components

Opening the Front Door

Tools Required:

• Cabinet key

Figure 23. Opening the front door

1. Unlock the front door with the key.

2. Pull out the locking mechanism and turn to open.

3. Open the door as required.

Closing the Front Door
1. Close the door.

2. Turn the locking mechanism to close and push back into place.

3. Lock the front door with the key.
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Opening / Closing the Integrated Console
The server is equipped with an integrated console for local administration and maintenance
operations.

Figure 24. Integrated console

To open the integrated console:

1. Slide the console forward until it clicks into place.

2. Use the front bar to lift the screen panel into position.

To close the integrated console:

1. Press the 2 buttons marked PUSH on either side of the keyboard panel to release the
console.

2. Lower the front bar to close the screen panel.

3. Slide the console back into the cabinet.
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Checking PMB Code Wheel Settings
Up to 16 Central Subsystems can be linked, via Platform Management Boards (PMBs) to a
single PAP unit, to provide a single point of administration and maintenance.

Each PMB is equipped with two code wheels used to identify each Central Subsystem and
each CSS module in your configuration. These code wheels are set prior to shipping
(factory default setting), according to configuration.

Each PMB is equipped with two code wheels used to identify each Central Subsystem and
each CSS module in the Customer’s configuration. These code wheels are set prior to
shipping (factory default setting), according to configuration.

CSS
CSS

PMB Code Wheel
PAM

CSS HW Identifier

CSS Module
PMB Code WheelCSS

PMB Code Wheel CSS HW Identifier
CSS Module 0 CSS Module 1

1st 0 00 0 1

2nd 1 01 0 1

3rd 2 02 0 1

4th 3 03 0 1

5th 4 04 0 1

6th 5 05 0 1

7th 6 06 0 1

8th 7 07 0 1

9th 8 08 0 1

10th 9 09 0 1

11th A 10 0 1

12th B 11 0 1

13th C 12 0 1

14th D 13 0 1

15th E 14 0 1

16th F 15 0 1

Figure 25. PMB code wheel settings
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Checking Server Cabling

  Important: 
Cables to external peripherals must NOT be connected before powering up the server
for the first time.
These cables must only be connected once server operation has been checked.

All internal cabinet cables are pre–connected before shipping. However, cables may
become loose during shipping and you are advised to check for loose cables before
powering up the server.

Refer to the NovaScale 5000/6000 Series Cabling Guide, 86 A1 34ER for details.

Connecting the Server to the Site Power Supply
The Customer is responsible for ensuring that the electrical network is compliant with the
standards set out in the Site Preparation Guide, 86 A1 87EF.

 CAUTION:
Only duly certified electricians may connect the server to the power supply, under the
Customer’s responsibility. The server is NOT equipped with a circuit breaker. The
circuit breakers referred to in this section are the SITE circuit breakers supplied by
the Customer.

Safety Recommendations

 DANGER
An electrical outlet that is not correctly wired could place hazardous voltage on metal
parts of the server or the devices that attach to the server. It is the Customer’s
responsibility to ensure that the outlet is correctly wired and grounded to prevent an
electrical shock. 
Use one hand, when possible, to connect or disconnect signal cables to prevent a
possible shock from touching two surfaces with different electrical potentials.

 CAUTION:
The server is equipped with three–wire (phase/phase/ground) power cables for user
safety. Use these power cables with properly grounded electrical outlets to avoid
electrical shock.

1. The server has more than one power supply cable. Follow procedures for removal
of power from the server when directed.

2. Energy hazard, remove all jewelry before servicing.
3. Check that the dedicated power supply circuit breakers are OFF.
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Powering Up the Server to the Standby Mode
Once the PDU cables have been connected to the power outlets at the base of the cabinet,
request the Customer to turn the site power supply circuit breakers ON.

The Platform Management Board (PMB) in each CSS module automatically powers up to
the standby mode (48V) and the Platform Administration Processor (PAP) unit automatically
boots Microsoft Windows software. Server operation can now be checked.

 Note:
It may take several seconds for something to be displayed on the monitor.

If the server does not initialize to standby (48V) or if an incident occrus, refer to
Troubleshooting Guide, 86 A7 91EF and NovaScale 5000/6000 Series Praxidiag
Diagnostics Guide.



2-7Setup Procedure

Checking Server Operation
Once the server has been installed and powered up, correct operation must be checked.

  Important: 
The server must be fully checked with factory default data.
See the Read Me First booklet delivered with the system 24 hours before the scheduled
installation date for factory default data.

Launching PAM Software
The server is equipped with an integrated Platform Administration and Maintenance
software package, otherwise known as PAM software.

One part of PAM software is an embedded application (MAESTRO) running on the Platform
Management Boards (PMB) and the other is an external application running on the Platform
Administration Processor (PAP) unit under Microsoft Windows.

You will use the secured PAM Web–based interface to operate, monitor, and configure the
server.

Once the Microsoft Windows software on the PAP unit has been booted, you will be
requested to supply a User Name and Password to open a Windows)  session. The session
MUST be started for the first time with the following factory default User Name and
Password:

User Name Administrator

Password administrator

  Important: 
The factory default User Name and Password are used by the authorized Customer
Service Engineer during the setup procedure ONLY.
Factory default data must be replaced by Customer data once the system check has
been successfully completed. See Completing PAP Unit Configuration on page 2-28.
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To complete installation, you need to open a Customer Administrator and a Support
Administrator PAM session.

To open a Customer Administrator PAM session:

1. From the Microsoft Windows desktop, double–click the Internet Explorer icon
(http://localhost/PAM).

2. When prompted, request the Customer Administrator to enter the default User Name
and Password:

Customer Administrator

User Name Administrator

Password administrator

The PAM home page appears.

 Note:
The PAM tree building process may take one to two minutes.

To open a Support Administrator PAM session:

1. From the Microsoft Windows desktop, double–click the Internet Explorer icon
(http://localhost//PAM).

2. When prompted, enter the predefined User Name and Password.

The PAM Home Page appears.
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PAM User Interface
The PAM user interface is divided into three areas in the browser window: a Status pane, a
PAM Tree pane, and a Control pane.

A

B

C

A  Status pane, on page 2-10

B  PAM Tree pane, on page 2-11

C  Control pane, on page 2-10

Figure 26. PAM user interface

 Note:
For further details about the PAM user interface, please consult the User’s Guide.
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Checking Server Status via PAM
The PAM user interface allows you to check system status at a glance. If the Functional
Status icon in the Status pane and the CSS Availability Status bar are green, the server
is ready to be powered up.

PAM Status Pane
The Status pane, which is automatically refreshed every few seconds, provides quick
access to the following synthetic information:

• Functional Status: if the system is operating correctly, the status icon is green,

• Event Messages: shows the number and maximum severity of pending event messages,

• CSS Availability Status: if the CSS Module PMB is detected as present, is configured
correctly, and is ready to operate, the status bar is green.

A System Functional Status icon E CSS Availability Status icon

B Presence/Functional Status toggle button F Event Message Severity icon

C Event Message Viewer New Event Message icon

D Pending Event Message icon

Figure 27. Status pane

PAM Control Pane
When an item is selected in the PAM Tree pane, details and related commands are
displayed in the Control pane, which is automatically refreshed at one minute intervals.
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CSS Availability Status Bar
The CSS availability status bar reflects the operational status of the data link(s) between the
Platform Management Board (PMB) embedded in each CSS Module and the PAP Unit.
Each CSS module is represented by a zone in the status bar.

• When a CSS Module PMB is detected as PRESENT, the corresponding zone in the
status bar is GREEN.

• When a CSS Module PMB is detected as ABSENT, the corresponding zone in the status
bar is RED.

• When you hover the mouse over the status bar, an Infotip displays the presence status
of CSS Module PMB – PAP Unit data links.

The following figure represents the status bar for a bi–module server. One CSS Module
PMB is detected as PRESENT and the other is detected as ABSENT.

A: Bar red (CSS Module_0 not available)

Figure 28. CSS Module availability status bar (bi–module server)

PAM Tree Pane

 Note:
The PAM tree builiding process may take one to two minutes. The PAM tree pane is
refreshed on request.

The PAM Tree pane provides access to server administration and maintenance features:

Tree Nodes Function

Domain Manager to power on / off and manage domains. 

Hardware Monitor to display the status of hardware components and assemblies. 

History Manager to view logs and manage archives.

Servicing Tools to install, maintain, and update the server.

Configuration Tasks to customize server features.

Table 1. PAM Tree nodes
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PAM Tree Toolbar

The PAM Tree toolbar, located at the top of the PAM Tree, is used to refresh, expand, or
collapse the tree display.

Toolbar Buttons Explanation

Refresh /rebuild the PAM Tree to view changes.

Expand the complete tree.

Collapse the complete tree.

Expand selected node.

Collapse selected node.

View the related Help topic.

Figure 29. PAM Tree toolbar
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Toggling the Local / Integrated Console Display
During the powering up / down sequences, you will be requested to toggle the local /
integrated console from the PAP unit display to the server domain display, or vice versa, as
explained below.

 CAUTION:
Access to the local / integrated console should be restricted to Customer / Support
Administrators and Operators ONLY to avoid inadvertent damage to software and/or
hardware components.

The KVM Switch allows the integrated console to be used as the local server domain and
local PAP unit console. KVM ports are configured as shown in Table 2.

NovaScale 5xx5 Server

8–Port KVM Switch
(MasterView)

Console Display Domain

Port 1 PAP Unit N/A

Port 2 Server Domain N/A

NovaScale 6xx5 Server

8–Port KVM Switch Console Display Domain

Port 1 PAP Unit N/A

Port 2 CSS0–Mod0–IO0 MyOperations–xx–1

Port 3 CSS0–Mod0–IO1 MyOperations–xx–2

or

16–Port KVM Switch Console Display Domain

Port 1 PAP Unit N/A

Port 3 CSS0–Mod0–IO0 MyOperations–xx–1

Port 4 CSS0–Mod0–IO1 MyOperations–xx–2

Port 5 CSS0–Mod1–IO0 MyOperations–xx–3

Port 6 CSS0–Mod1–IO1 MyOperations–xx–4

Table 2. KVM port configuration

You can easily toggle from the server domain display to the PAP unit display, or vice versa:

1. From the keyboard, press the Control key twice to display the KVM Switch Command
Menu.

2. Select the required port with the ↑↓ keys and press Enter.

3. The selected display appears on the Console monitor.
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Powering Up / Down Server Domains
When server status has been checked – system functional status icon and CSS availability
status bar green in the Status pane – the server can be powered up.

To power up / down the server, see:

• Powering Up / Down the NovaScale 5xx5 Server Domain, on page 2-14

• Powering Up / Down NovaScale 6085 Server Domains, on page 2-16

• Powering Up / Down NovaScale 6165 Server Domains, on page 2-21

Powering Up the NovaScale 5xx5 Server Domain
NovaScale 5xx5 Servers are designed to operate as single SMP systems and are delivered
with one pre–configured domain.

When server status has been checked – functional status icon and CSS availability status
bar green in the Status pane – the server domain can be powered up.

 Note:
If an error dialog box appears during these sequences, see  Managing Domains in the
User’s Guide.

To power up / down server domains:

1. From the Customer Administrator / Operator PAM Tree, click Domain Manager to open
the Control pane. A dialog box invites you to load the server domain.

2. Click OK to confirm. The domain appears in the Control pane. If the domain is ready to
be powered up, INACTIVE is displayed in the Domain State box and the Power On
button is accessible.

3. Select the domain and click Power On to power up the server domain and associated
hardware components.

Operating System type

CSS availability status indicator 
GREEN

Functional status icon &

Figure 30. Domain Manager Control pane
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4. Follow the power–on steps displayed in the Domain State box, until RUNNING is
displayed.

Figure 31. Domain state

5. Toggle the local / integrated console from the PAP unit display to the server display. See
Toggling the Local / Integrated Console Display, on page 2-13.

6. Wait for the Operating System to load completely. The domain is now fully functional.

7. Check the Operating System environment pre–installed on the domain.

8. Shut down the Operating System to power down the domain to the stand–by mode.

9. Toggle the local / integrated console to the PAP unit display. INACTIVE is displayed in
the Domain State box and the Power ON button is accessible.

 Notes:

• If the same PAP unit administers more than one server, all servers can be powered on
simultaneously as follows:

a. Click Multiple Power. The Multiple Power Domains On/Off dialog opens.

b. Click Power On All → Execute to power on the servers and associated hardware
components.

• For further details about the Power ON / OFF sequences, see Powering ON a Domain
and Powering OFF a Domain in the User’s Guide.

Shutting Down / Restarting the Server
1. From the PAM home page, click File → Close to return to the Microsoft Windows

desktop.

2. Shut down the PAP unit by selecting the Shut Down command in the Start Menu.

3. Request the Customer to turn the power supply circuit breakers OFF.

4. Request the Customer to turn the power supply circuit breakers ON.

The Platform Management Board (PMB) in each CSS module automatically powers up
to the standby mode (48V) and the Platform Administration Processor (PAP) unit
automatically boots Microsoft Windows software. Server operation can now be
checked.
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Powering Up NovaScale 6085 Server Domains
The NovaScale 6085 Server is designed to operate as two hardware–independent SMP
systems, or domains.

For easy configuration and optimum use of the physical and logical resources required for
simultaneous operation, domains are defined via the PAM Domain Scheme wizard.

The server is delivered with a default scheme, or configuration file, called
MyOperationsScheme–xx containing two domains, MyOperations–xx–1 and
MyOperations–xx–2. An Operating System instance is pre–installed on each domain boot
disk (EFI LUN). According to Customer requirements, identical or different Operating
System instances may be pre–installed on each EFI LUN. The default scheme allows
domains to be booted simultaneously or independently. A brief summary of the organization
of physical and logical resources in MyOperationsScheme–xx is given in the following
table.

 Notes:

• xx in the default scheme and domain names represents the Central Subsystem HW
identifier (from 00 to 16). For further details, refer to Checking PMB Code Wheel Settings,
on page 2-4.

• In the screen shots, tables, and examples in this guide:

– MyOperationsScheme–xx is referred to as MyOperationsScheme

– MyOperations–xx–1 is referred to as MyOperations–1

– MyOperations–xx–2 is referred to as MyOperations–2

• In the screen shots in this guide, an instance of Microsoft Windows is pre–installed on
MyOperations–xx–1 and an instance of Linux is pre–installed on MyOperations–xx–2.

Operating System type is indicated by the Microsoft Windows or Linux  logo in the
Domain Identities box.
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MyOperationsScheme Organization

Domain Identity: MyOperations–1

Hardware Cell Cell_0

Operating System
(customer–specific) Windows Linuxor

EFI LUN** *<MyServer>_0LU0   /  <SAN>LUN0

IOC Module0_IOC0

QBBs Module0_QBB0

Domain KVM Ports ***CSS0_Mod0_IO0

Domain Identity: MyOperations–2

Hardware Cell Cell_1

Operating System
(customer–specific) Windows Linuxor

EFI LUN** *<MyServer>_0LU0   /  <SAN>LUN1

IOC Module0_IOC1

QBBs Module0_QBB1

Domain KVM Ports ***CSS0_Mod0_IO1

* <MyServer> = default server name, e.g.: NS6085–0

* <SAN> = default SAN name

** EFI LUN: xLUx = Local boot LUN device location (ModxLUIOx):
      0LU0 = LUN device located in Module0_DIB0 or connected to Module0_IOC0
      0LU1 = LUN device located in Module0_DIB1 or connected to Module0_IOC1
***CSSx = CSS number, Modx = Module number, IOx = IO box number
Table 3. MyOperationsScheme organization – mono–module server
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To power up / down server domains:

 Note:
If an error dialog box appears during these sequences, see Managing Domains in the
User’s Guide.

1. From the PAM Tree, click Domain Manager to open the Control pane. You are invited
to load a domain configuration scheme.

2. Click Schemes. The Schemes List dialog opens displaying the pre–configured scheme.

3. Select MyOperationsScheme and click Apply.

Figure 32. Domain schemes list dialog

4. When requested, click Yes to confirm. MyOperations–1 and MyOperations–2 domains
are loaded in the Control pane.
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If the domains are ready to be powered up, INACTIVE is displayed in the Domain State
boxes and the Power On button is accessible for each domain.

CSS availability status indicator 
GREEN

Functional status icon &

Operating System type

Figure 33. Domain Manager Control pane

5. Click Multiple Power. The Multiple Power Domains On/Off dialog opens.

6. Click Power On All → Execute to simultaneously power on the domains and associated
hardware components.

Figure 34. Multiple power dialog
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 Note:
Domains can also be powered on sequentially from the Control pane:

• Select MyOperations–1 in the Control pane and click Power On to power up the
domain and associated hardware components.

• Select MyOperations–2 in the Control pane and click Power On to power up the
domain and associated hardware components.

7. Follow the power–on steps displayed in the Domain State boxes, until RUNNING is
displayed in both Domain State boxes.

Figure 35. Domain state

8. Toggle the local / integrated console from the PAP unit display to MyOperations–1
display. See Toggling the Local / Integrated Console Display, on page 2-13.

9. Wait for the Operating System to load completely. MyOperations–1 domain is now fully
functional.

10.Toggle the local / integrated console from MyOperations–1 display to MyOperations–2
display.

11.Wait for the Operating System to load completely. MyOperations–2 domain is now fully
functional.

12.Check the Operating System environment pre–installed on each domain.

13.Shut down each Operating System to power down the corresponding domain to the
stand–by mode.

14.Toggle the local / integrated console to the PAP unit display. INACTIVE is displayed in
the Domain State boxes and the Power ON button is accessible for each domain.

 Notes:
For further details about the Power ON / OFF sequences, see Powering ON a Domain and
Powering OFF a Domain in the User’s Guide.

Shutting Down / Restarting the Server
1. From the PAM home page, click File → Close to return to the Microsoft Windows

desktop.

2. Shut down the PAP unit by selecting the Shut Down command in the Start Menu.

3. Request the Customer to turn the power supply circuit breakers OFF.

4. Request the Customer to turn the power supply circuit breakers ON.

The Platform Management Board (PMB) in the CSS module automatically powers up to
the standby mode (48V) and the Platform Administration Processor (PAP) unit
automatically boots Microsoft Windows software.
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Powering Up NovaScale 6165 Server Domains
The NovaScale 6165 Server is designed to operate as four hardware–independent SMP
systems, or domains.

For easy configuration and optimum use of the physical and logical resources required for
simultaneous operation, domains are defined via the PAM Domain Scheme wizard. For
further details about domain configuration, see Configuring Domains, in the User’s Guide.

The server is delivered with a default scheme, or configuration file, called
MyOperationsScheme–xx, containing up to four domains, MyOperations–xx–1,
MyOperations–xx–2, MyOperations–xx–3, MyOperations–xx–4. An Operating System
instance is pre–installed on each domain boot disk (EFI LUN).  According to Customer
requirements, identical or different Operating System instances may be pre–installed on
each EFI LUN. The default scheme allows you to simultaneously boot all domains. A brief
summary of the organization of physical and logical resources in
MyOperationsScheme–xx is given in the following table.

 Notes:

• xx in the default scheme and domain names represents the Central Subsystem HW
identifier (from 00 to 16). For further details, refer to Checking PMB Code Wheel Settings,
on page 2-4.

• In the screen shots, tables, and examples in this guide:

– MyOperationsScheme–xx is referred to as MyOperationsScheme

– MyOperations–xx–1 is referred to as MyOperations–1

– MyOperations–xx–2 is referred to as MyOperations–2

– MyOperations–xx–3 is referred to as MyOperations–3

– MyOperations–xx–4 is referred to as MyOperations–4

• In the screen shots in this guide, an instance of Microsoft Windows is pre–installed on
MyOperations–xx–1 and MyOperations–xx–3 and an instance of Linux is pre–installed
on MyOperations–xx–2 and MyOperations–xx–4.

Operating System type is indicated by the Microsoft Windows or Linux  logo in the
Domain Identities box.
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MyOperationsScheme Organization

Domain Identity: MyOperations–1

Hardware Cell Cell_0

Operating System
(customer–specific) Windows Linuxor

EFI LUN** *<MyServer>_0LU0   /  <SAN>LUN0

IOC Module0_IOC0

QBBs Module0_QBB0

Domain KVM Ports ***CSS0_Mod0_IO0

Domain Identity: MyOperations–2

Hardware Cell Cell_1

Operating System
(customer–specific) Windows Linuxor

EFI LUN** *<MyServer>_0LU0   /  <SAN>LUN1

IOC Module0_IOC1

QBBs Module0_QBB1

Domain KVM Ports ***CSS0_Mod0_IO1

Domain Identity: MyOperations–3
(NovaScale 6165 Server)

Hardware Cell Cell_2

Operating System
(customer–specific) Windows Linuxor

EFI LUN** *<MyServer>_0LU0   /  <SAN>LUN2

IOC Module1_IOC0

QBBs Module1_QBB0

Domain KVM Ports ***CSS0_Mod1_IO0

Domain Identity: MyOperations–4
(NovaScale 6165 Server)

Hardware Cell Cell_3

Operating System
(customer–specific) Windows Linuxor

EFI LUN** *<MyServer>_0LU0   /  <SAN>LUN3

IOC Module1_IOC1

QBBs Module1_QBB1

Domain KVM Ports ***CSS0_Mod1_IO1

* <MyServer> = default server name, e.g.: NS6085–0, NS6165–0

* <SAN> = default SAN name

** EFI LUN: xLUx = Local boot LUN device location (ModxLUIOx):
      0LU0 = LUN device located in Module0_DIB0 or connected to Module0_IOC0
      0LU1 = LUN device located in Module0_DIB1 or connected to Module0_IOC1
      0LU2 = LUN device located in Module1_DIB0 or connected to Module1_IOC0
      0LU3 = LUN device located in Module1_DIB1 or connected to Module1_IOC1

***CSSx = CSS number, Modx = Module number, IOx = IO box number
Table 4. MyOperations Scheme organization – bi–module server
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To power up / down server domains:

 Note:
If an error dialog box appears during these sequences, see Managing Domains in the
User’s Guide.

1. From the Customer Administrator PAM Tree, click Domain Manager to open the
Control pane. You are invited to load a Domain Scheme.

2. Click Schemes. The Schemes List dialog opens displaying the pre–configured scheme.

3. Select MyOperationsScheme and click Apply.

Figure 36. Domain schemes list dialog

4. When requested, click Yes to confirm. MyOperations–1, MyOperations–2,
MyOperations–3, and MyOperations–4 domains are loaded in the Control pane.
If the domains are ready to be powered up, INACTIVE is displayed in the Domain State
boxes and the Power On button is accessible for each domain.
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CSS availability status indicator 
GREEN Operating System type

Functional status icon &

Figure 37. Domain Manager Control pane

5. Click Multiple Power. The Multiple Power Domains On/Off dialog opens.

6. Click Power On All → Execute to simultaneously power on the domains and associated
hardware components.

Figure 38. Multiple power dialog

 Note:
Domains can also be powered on sequentially from the Control pane:

• Select MyOperations–1 in the Control pane and click Power On to power up the
domain and associated hardware components. Repeat this step for each domain in the
Control pane.
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7. Follow the power–on steps displayed in the Domain State boxes, until RUNNING is
displayed in all Domain State boxes.

Figure 39. Domain state

8. Toggle the local / integrated console from the PAP unit display to the first domain display.
See Toggling the Local / Integrated Console Display, on page 2-13.

9. Wait for the Operating System to load completely. The domain is now fully functional.

10.Toggle the local / integrated console from this domain display to the next domain
display.

11.Wait for the Operating System to load completely. The domain is now fully functional.

12.Repeat Steps 10 and 11 for each domain.

13.Check the Operating System environment pre–installed on each domain.

14.Shut down each Operating System to power down the corresponding domain to the
stand–by mode.

15.Toggle the local / integrated console to the PAP unit display. INACTIVE is displayed in
the Domain State boxes and the Power ON button is accessible for each domain.

 Notes:
For further details about the Power ON / OFF sequences, see Powering ON a Domain and
Powering OFF a Domain in the User’s Guide.

Shutting Down / Restarting the Server
1. From the PAM home page, click File → Close to return to the Microsoft Windows

desktop.

2. Shut down the PAP unit by selecting the Shut Down command in the Start Menu.

3. Request the Customer to turn the power supply circuit breakers OFF.

4. Request the Customer to turn the power supply circuit breakers ON.

The Platform Management Board (PMB) in each CSS module automatically powers up
to the standby mode (48V) and the Platform Administration Processor (PAP) unit
automatically boots Microsoft Windows software.
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Changing the iStorage Manager User Name and Password
FDA 1x00 FC and FDA 2x00 FC subsystems are delivered with iStorage Manager (iSM)
software for integrated monitoring and centralized management.

The iSM Server / Client utility is installed on the PAP Unit desktop. The Customer can install
iSM Client on any standard PC running under Microsoft Windows (2000 or later).

Before using iSM, the Customer is advised to replace the factory default User Name and
Password.

To change the iStorage Manager User Name and Password:

1. From the PAP Unit Microsoft Windows desktop, click:
Start → Programs → NEC Storage Manager Server → Setting Utility.

2. Select the Users tab. The default User Name and User Level is displayed in the User
List.

Default User Name Administrator

Default User Level L3

Default Password administrator

3. Select Administrator from the User List and click Edit to open the User – Edit dialog
box.

4. Change the User Name and Password and check that the L3 radio button is highlighted.

5. Click OK.

6. A dialog box requests you to restart iSM to apply changes. Click Yes.

7. From the PAP Unit Microsoft Windows desktop, click:
Start → Programs → Administrative Tools → Services.

8. Select NEC Storage Manager → Action → Stop to stop iSM.

9. Click Action → Start to restart iSM. Changes are applied.

 Note:
Please refer to the iSM documentation delivered with the server for further details.
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Changing the S@N.IT Password
FDA 1x00 FC and FDA 2x00 FC subsystems are delivered with S@N.IT software for
integrated monitoring and centralized management.

The S@N.IT Server / Client utility is installed on the PAP Unit desktop. The Customer can
install S@N.IT Client on any standard PC running under Microsoft Windows (2000 or later).

Before using S@N.IT, the Customer is advised to replace the factory default sanadmin
User Password.

 Note:
The default sanadmin User Name CANNOT be changed.

To change the S@N.IT sanadmin User Password:

1. From the PAP Unit Microsoft Windows desktop, click:
Start → Programs → S@N.IT.

2. Enter the Configuration →  Set Password menu.

3. Select the sanadmin user.

4. Type your new password in the New Password field.

5. Confirm your new password by retyping it in the Confirm Password field.

6. Click OK to save changes.

 Note:
Please refer to the S@N.IT documentation delivered with the server for further details.
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Completing PAP Unit Configuration

  Important: 
Before proceeding to complete PAP Unit configuration:

• Refer to the PAM Writing Rules, on page B-4

• Check Regional, Date/Time, and Time Zone settings

Changing the Default PAP Unit Name
Request the Customer to change the default PAP unit name <PAP> from the  Microsoft
Windows Network configuration utility.

To change the default PAP unit name:

7. From the Microsoft Windows desktop, select:
MyComputer → Properties → Network Identification → Properties.

8. Complete the fields as required.

Launching the PAP Configuration Setup Wizard
To complete PAP unit configuration:

1. Request the Customer to provide the Installation Setup Data listed in the Read Me First
booklet enclosed in the Open Me First kit.

2. Open a new Microsoft Windows session with the predefined User Name and Password.

User Name Administrator

Password administrator

3. From the Microsoft Windows desktop, click:
Start → Program Files → Platform Administration and Maintenance → PAP
Configuration
to launch the PAP configuration setup wizard which guides you through the PAP Unit
configuration procedure (approximately 10 minutes).
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The PAP configuration setup wizard dialog opens.

Figure 40. PAP configuration wizard dialog

4. Click the Check PAM Release Type button. The Release Type dialog opens.

Figure 41. Release type dialog

5. Check that the release type is correct:
NovaScale 5xx5 Servers
The MonoDomain radio button must be highlighted.
NovaScale 6xx5 Servers
The MultiDomain radio button must be highlighted.

 Note:
If the release type is not correct, select the required release type and click Apply
change.
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6. Click Back to PAP Configuration to customize the PAP unit with the Installation Setup
Data supplied by the Customer:

a. Click the Configure the Network button to configure Customer Enterprise LAN settings
and to change the default factory PAP unit network setting.

Figure 42. Network configuration dialog

b. Click the Change Windows Administrator Password button to change the PAP unit
Customer Administrator password.

Figure 43. Users configuration dialog
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c. Click the Configure PAM Software via the PAM Web Site button to open a Support
Administrator PAM session to complete Customer Information, Autocalls and Central
Subsystem configuration.

Figure 44. PAM configuration via Web site dialog

d. Click the Configure SAN Software Identities button to change the default S@N.IT
password and the ISM user name and password.

Figure 45. SAN software identities configuration dialog

  Important: 
You MUST enter the new S@N.IT and iSM user names and/or passwords
previously set by the Customer. See:

• Changing the iStorage Manager User Name and Password, on page 2-26

• Changing the S@N.IT Password, on page 2-27
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 Warning: 
Changes to Central Subsystem configuration are hazardous and must not be
performed until the server has been fully tested. 
If the Customer wants to rename the Central Subsystem, this entails removing
the existing Central Subsystem and adding a new Central Subsystem with the
required name. 
Default Domain Schemes will not be applicable to the new Central Subsystem
and must be redefined. 
See Configuring the Central Subsystem, on page 2-58.
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Configuring Customer Information
Customer information is used by PAM software for the PAM Tree display and to complete
Intervention Reports.

To configure Customer information:

1. From the PAM Tree, click Configuration Tasks → Customer Information. The
Customer Information configuration page opens.

2. Enter Customer data and click Save to confirm changes.

Figure 46. Customer Information configuration page

 Notes:

The value entered in the Site name field is used for the PAM Tree root node. The default
name is NovaScale.

The values entered in the other fields can be consulted by the Customer and / or Support
personnel.
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Configuring Autocalls
The Autocall feature is part of the BULL Remote Maintenance contract. It is used to
automatically route system events to the Remote Maintenance Center. Full details are given
in the BULL Remote Maintenance Guide.

If the Customer’s maintenance contract includes the Autocall feature, configure Autocall
parameters as follows:

1. Click Configuration Tasks → Autocalls. The Autocalls configuration page opens.

Figure 47. Autocalls Channel Settings control pane

2. Select the Enable Autocalls checkbox.

3. Select the Send Heartbeat checkbox and enter a value “in days” for the autocall channel
control in the Period box. Recommended value = 1.

4. Select the autocall dispatch mode :

– Local dispatch mode (default mode) sends autocalls to the local target directory
indicated under Local Settings,

– FTP dispatch mode sends autocalls to the server indicated under FTP Settings.

5. If Local dispatch mode (default mode) is selected, complete the Local Settings field
with the following information:

Field Explanation Value

Local target directory Default GTS directory used to store autocalls. c:\gts\session
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6. If FTP dispatch mode is selected, complete the FTP Settings fields with the following
information:

Field Explanation Value

Server name Remote Maintenance Center server IP address 127.0.0.1

Server port Default server port 21

Target directory Default server directory /autocall

Login Declared authorized user name X

Password Declared authorized user password X

7. If a modem connection is to be used:

a. From the PAP Unit Microsoft Windows desktop, configure the dial–up connection
(Control Panel → Phone and Modem Options).

b. From the PAM Autocalls Control Pane, select the Use modem connection
checkbox.

c. Use the Connection name drop–down menu to select the required modem
connection.

d. Complete the User name and Password fields with the declared authorized user
name and user password.

8. Return to the PAP Unit Microsoft Windows desktop to complete remote maintenance
setup as explained in the BULL Remote Maintenance Guide.

 Note:
Connection of the USB modem required for the Autocall feature is explained in Connecting
the USB Modem and External Devices, on page 2-56.
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Connecting the PAP Unit to the Customer’s Enterprise LAN

 CAUTION:
Remote access via the Web is a potential security hazard. Customers are strongly
advised to protect their systems with up–to–date protection devices such as
virus–prevention programs and firewalls, and to maintain a detailed record of
authorized users.

Once PAP unit configuration is complete, it can be connected to the Customer’s Enterprise
LAN.

The PAP unit provides two RJ45 Ethernet ports. The first is used for the internal server
network and the second for connection to the Customer’s Enterprise LAN for remote
platform administration and maintenance.

1. Open the rear door and remove the left side cover.

2. Guide the Enterprise network cable supplied by the Customer through the cable cut–out
at the base of the cabinet and up through the free space on the left side of the cabinet.

3. Access the PAP unit  RJ45 Ethernet ports from the rear of the cabinet.

or

Free Ethernet port

Figure 48. PAP unit free Ethernet port

4. Secure the Enterprise network cable to the left flange of the cabinet with the velcro
fasteners supplied in the Open Me First kit.

5. Close the rear door and refit the left side cover. 

  Important: 
If the PAP unit is not connected to the Customer’s Enterprise LAN, the remote
maintenance autocall and  certain event messaging options will not be enabled.
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Connecting to the PAM Web Site from a Remote
Computer/Workstation

  Important: 
For optimum security, before connecting to PAM from a remote computer, you are
advised to disconnect from your local Windows session on the PAP unit by clicking
Start → Log Off.

The PAM Software utility can be accessed from any PC running Microsoft Windows with the
Internet Explorer (6 or later) browser installed and/or from any workstation running Linux
with the Mozilla (1.6 or later) browser installed.

Enabling Remote Access to the PAM Web Site with Internet Explorer
1. From the remote computer, configure Internet Explorer to connect directly to the PAM

Web site:

a. From the Internet Explorer main menu bar, select Tools → Internet Options →
Home Page.

b. Type the PAM Web site URL defined during the PAP installation procedure in the
home page address field: http://<PAPname>/pam
(where <PAPname> is the name allocated to PAP unit during setup).

c. Save your changes and close Internet Explorer.
2. Launch Internet Explorer to connect directly to the PAM web site.

3. When prompted, enter the appropriate Administrator or Operator User Name and
Password. The PAM home page appears.

Enabling Remote Access to the PAM Web Site with Mozilla
1. From the remote computer, configure Mozilla to connect directly to the PAM Web site:

a. From the Mozilla main menu bar, select Edit → Preferences → Navigator.
b. Check the Home Page box and enter the PAM Web site URL defined during the PAP

installation procedure in the location field:
http://<PAPname>/pam
(where <PAPname> is the name allocated to PAP unit during setup).

c. Save your changes and close Mozilla.
2. Launch Mozilla to connect directly to the PAM web site.

3. When prompted, enter the appropriate Administrator or Operator User Name and
Password. The PAM home page appears.
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Enabling Remote Access to iSM on the Client Computer
FDA 1x00 FC and FDA 2x00 FC subsystems are delivered with iStorage Manager (iSM) for
integrated monitoring and centralized management.

The iSM Server / Client utility is installed on the PAP Unit desktop. The Customer can install
iSM Client on any standard PC running under Microsoft Windows (2000 or later).

To enable remote access to iSM:

1. Insert the iSM Client setup CD–Rom in the client computer.

2. Run the CLIENT\2000\ISMCE211.EXE program to launch the setup wizard which guides
you through the iSM Client configuration procedure.

3. When you are requested to select Setup Type, click basic + extended function →
Next.

4. Once setup is complete, launch iSM Client to connect to iSM Server. A dialog box
appears requesting you to set the environment for iSM Client.

5. From the iSM Client menu, click File → Environment Settings to open the Server
Settings page.

6. In the IP Address field, enter the PAP unit IP address allocated during the PAP unit
setup process. See Completing PAP Unit Configuration, on page 2-28.

7. Click OK to establish the connection.

8. When requested enter the User Name and Password and click OK. See Changing the
iStorage Manager User Name and Password, on page 2-26.
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Completing Operating System Setup
An Operating System instance is pre–installed on each domain boot disk. According to
Customer requirements, identical or different Operating System instances may be
pre–installed on each EFI LUN.

A list of the Customer data required to complete setup is given in the Read Me First booklet
delivered with the system 24 hours before the scheduled installation date.

 Note:
For further information about the server booting environment, see Using EFI Utilities in the
User’s Guide.

To complete Operating System setup, see:

• NovaScale 5xx5 Servers – Operating System Setup, on page 2-40

• NovaScale 6085 Server – Operating System Setup, on page 2-44

• NovaScale 6165 Server – Operating System Setup, on page 2-48
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NovaScale 5xx5 Servers – Operating System Setup
An Operating System instance is pre–installed on the domain boot disk:

0LU0 = LUN device located in Module0_DIB0 or connected to Module0_IOC0

Before proceeding to complete setup on the domain:

1. From the Customer Administrator PAM Tree, click Domain Manager. 
MyOperations–1 domain is displayed in the Control pane.

2. Check Operating System type:

Microsoft Windows or Linux  logo in the Domain Identities box.

3. Locate the DVD–Rom drive:

MyOperations–1: Module0, IPD0

4. Note the KVM port for the domain:

MyOperations–1: CSS0–Mod0–IO0

5. Check that the Customer has supplied the System and Networking data required to
complete setup and customize the system. See the Installation Setup Data tables in the
Read Me First document supplied on delivery.

To complete Operating System setup, see:

• Microsoft Windows Setup, on page 2-41

• Linux Redhat Setup, on page 2-42

• Novell SuSe Setup, on page 2-43
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 Microsoft Windows Setup

 Warning: 
Most of the options selected and validated during the setup sequence can be
modified. However, special attention is to be paid when selecting and validating the
Licensing Mode (Per Seat / Per Server). If selected and validated, the “Per Server”
Licensing Mode option CAN be modified. If selected and validated, the “Per Seat”
Licensing Mode CANNOT be modified.

1. Check that the Microsoft Windows CD–Rom labeled “TO BE COMPLETED” is ready for
use and that the yellow sticker with the 25–character Microsoft Windows Product Key
required to complete setup is clearly visible inside the cabinet.

2. SCSI Disk Racks
Locate the corresponding SCSI disk rack and unlock all system and data disks not used
by the current Operating System instance.
See Preparing SCSI Disk Racks, on page 2-53.
FC Disk Racks
No action.

3. Select the Microsoft Windows domain in the Control pane and click Power On to power
up the domain and associated hardware components.

4. Toggle the local / integrated console from the PAP unit display to the domain display.
See Toggling the Local / Integrated Console Display, on page 2-13.

5. Check Regional, Date/Time, and Time Zone settings under EFI.

6. The setup wizard is launched automatically and guides the Customer and the Customer
Service Engineer through the setup completion procedure (approximately 30 minutes).

Once setup is complete, Microsoft Windows shuts down, the system domain is rebooted
and the server configuration wizard is launched automatically.

 Note:
Server configuration is a Customer–specific task and is not performed by the Customer
Service Engineer during installation. Once the system has been fully installed, the
Customer Administrator may launch this wizard to configure and manage Server Roles.

7. Close the server configuration wizard.

8. Shut down the domain and associated hardware components by selecting the Shut
Down command in the Start Menu.

9. Toggle the local / integrated console from the domain display to the PAP unit display.
See Toggling the Local / Integrated Console Display, on page 2-13.

10.SCSI Disk Racks
Lock the disks unlocked before launching the setup completion procedure.
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Linux  RedHat Setup
1. SCSI Disk Racks

Locate the corresponding SCSI disk rack and unlock all system and data disks not used
by the current Operating System instance.
See Preparing SCSI Disk Racks, on page 2-53.
FC Disk Racks
No action.

2. Select the Linux RedHat domain in the Control pane scheme and click Power On to
power up the domain and associated hardware components.

3. Toggle the local / integrated console from the PAP unit display to the domain display.
See Toggling the Local / Integrated Console Display, on page 2-13.

4. Check Regional, Date/Time, and Time Zone settings.

5. Place the Linux RedHat CD–Rom in the drive. Setup is completed via the Webmin
administration tool:

a. Enter the Webmin URL:
http://<localhost>:10000. The Login to Webmin dialog box opens.

b. Enter the default User Name and Password, followed by Enter. The Webmin home
page opens.

User Name root

Password root

c. Click the Networking icon to open the Networking main page.
d. Click Network Configuration → Network Interfaces. In the Interfaces Activated at

Boot Time field, click Add a new interface to open the Create Bootup Interface
configuration page. Complete the required fields with the data supplied by the
Customer and click Create.

e. From the Interfaces Activated at Boot Time field, select the new interface. The Edit
Bootup Interface page opens. Check settings and click Save and Apply → Return
to network configuration.

f. Click Routing and Gateways to open the Routing and Gateways configuration
page. Complete the required fields with the data supplied by the Customer and click
Save → Return to network configuration.

g. Click DNS Client to open the DNS Client Options configuration page. Complete the
required fields with the data supplied by the Customer and click Save → Return to
network configuration.

h. Click Host Addresses → Add a new host address to open the Host and
Addresses configuration box. Complete the required fields with the data supplied by
the Customer and click Create → Return to host addresses list → Return to
network configuration → Return to index → System → Bootup and Shutdown to
create a new bootup and shutdown action.

i. From the action list, select Network to display the Edit Action page and click →
Restart Now → Return to action → Return to bootup and shutdown actions →
Return to index → Log Out to exit Webmin. Once setup is complete, the network is
activated.

6. Shut down the domain and associated hardware components by selecting the Shut
Down command in the Start Menu.

7. Toggle the local / integrated console from the domain display to the PAP unit display.
See Toggling the Local / Integrated Console Display, on page 2-13.

8. SCSI Disk Racks
Lock the disks unlocked before launching the setup completion procedure.
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Novell  SuSe Setup
1. SCSI Disk Racks

Locate the corresponding SCSI disk rack and unlock all system and data disks not used
by the current Operating System instance.
See Preparing SCSI Disk Racks, on page 2-53.
FC Disk Racks
No action.

2. Select the Linux SuSe domain in the Control pane scheme and click Power On to
power up the domain and associated hardware components.

3. Toggle the local / integrated console from the PAP unit display to the domain display.
See Toggling the Local / Integrated Console Display, on page 2-13.

4. Check Regional, Date/Time, and Time Zone settings.

5. Place the Linux SuSe CD–Rom in the drive. Setup is completed via the Yast Control
Center administration tool:

a. Type the default User Name and Password, followed by Enter.

User Name root

Password root

b. Enter yast2 (graphical mode) or yast (non–graphical mode) to open the Yast Control
Center main page.

 Note:
Use the <Tab> and <Arrow> keys to navigate through the menus.

c. Click Network/Basic → Network Card Configuration.
d. Select the required network card and click Configure.
e. From the Network Address Setup page, select the setup method and complete the

required fields with the data supplied by the Customer.
f. From the Details settings area, click Host name and name server. Complete the

required fields and click Next.
g. From the Details settings area, click Routing. Complete the required fields and click

Next to return to the Network Card Configuration page. Your network card is
displayed in the Already configured devices area.

h. Click Close to exit Yast Control Center. Once setup is complete, the network is
activated.

6. Shut down the domain and associated hardware components by selecting the Shut
Down command in the Start Menu.

7. Toggle the local / integrated console from the domain display to the PAP unit display.
See Toggling the Local / Integrated Console Display, on page 2-13.

8. SCSI Disk Racks
Lock the disks unlocked before launching the setup completion procedure.
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NovaScale 6085 Server – Operating System Setup
An Operating System instance is pre–installed on each domain boot disk (EFI LUN):

0LU0 = LUN device located in Module0_DIB0 or connected to Module0_IOC0

0LU1 = LUN device located in Module0_DIB1 or connected to Module0_IOC1

According to Customer requirements, identical or different Operating System instances may
be pre–installed on each EFI LUN. Operating System setup must be completed for each
Operating System instance.

 Note:
In the screen shots, tables, and examples in this guide:

– MyOperationsScheme–xx is referred to as MyOperationsScheme

– MyOperations–xx–1 is referred to as MyOperations–1

– MyOperations–xx–2 is referred to as MyOperations–2

Before proceeding to complete setup on each domain:

1. From the Customer Administrator PAM Tree, click Domain Manager. 
MyOperations–1 and MyOperations–2 domains are displayed in the Control pane.

2. Check Operating System type for each domain:

Microsoft Windows or Linux  logo in the Domain Identities box.

3. Locate the corresponding DVD–Rom drive:

MyOperations–1: Module0, IPD0

MyOperations–2: Module0, IPD1

4. Note KVM ports for each domain:

MyOperations–1: CSS0–Mod0–IO0

MyOperations–2: CSS0–Mod0–IO1

5. Check that the Customer has supplied the System and Networking data required to
complete setup and customize the system. See the Installation Setup Data tables in the
Read Me First document supplied on delivery.

To complete Operating System setup, see:

• Microsoft Windows Setup, on page 2-45

• Linux Redhat Setup, on page 2-46

• Novell SuSe Setup, on page 2-47
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 Microsoft Windows Setup

 Warning: 
Most of the options selected and validated during the setup sequence can be
modified. However, special attention is to be paid when selecting and validating the
Licensing Mode (Per Seat / Per Server). If selected and validated, the “Per Server”
Licensing Mode option CAN be modified. If selected and validated, the “Per Seat”
Licensing Mode CANNOT be modified.

1. Check that the Microsoft Windows CD–Rom labeled “TO BE COMPLETED” is ready for
use and that the yellow sticker with the 25–character Microsoft Windows Product Key
required to complete setup is clearly visible inside the cabinet.

2. SCSI Disk Racks
Locate the corresponding SCSI disk rack and unlock all system and data disks not used
by the current Operating System instance.
See Preparing SCSI Disk Racks, on page 2-53.
FC Disk Racks
No action.

3. Select the first Microsoft Windows domain in the Control pane and click Power On to
power up the domain and associated hardware components.

4. Toggle the local / integrated console from the PAP unit display to MyOperations–1 or
MyOperations–2 display, as required. See Toggling the Local / Integrated Console
Display, on page 2-13.

5. Check Regional, Date/Time, and Time Zone settings under EFI.

6. The setup wizard is launched automatically and guides the Customer and the Customer
Service Engineer through the setup completion procedure (approximately 30 minutes).

Once setup is complete, Microsoft Windows shuts down, the system domain is rebooted
and the server configuration wizard is launched automatically.

 Note:
Server configuration is a Customer–specific task and is not performed by the Customer
Service Engineer during installation. Once the system has been fully installed, the
Customer Administrator may launch this wizard to configure and manage Server Roles.

7. Close the server configuration wizard.

8. Shut down the domain and associated hardware components by selecting the Shut
Down command in the Start Menu.

9. Toggle the local / integrated console from the domain display to the PAP unit display.
See Toggling the Local / Integrated Console Display, on page 2-13.

10.Update Domain Identity Management Parameters:

a. From the Customer Administrator PAM Tree, click Domains → Identities.
b. Select the corresponding Domain Identity and click Edit. The Edit Identity dialog

opens.
c. Complete the Network Name, IP Address, and URL fields with the data entered

during the setup completion procedure.
11.Repeat steps 1 to 10 for each pre–installed Microsoft Windows instance.

12.SCSI Disk Racks
Lock the disks unlocked before launching the setup completion procedure.
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Linux RedHat Setup
1. SCSI Disk Racks

Locate the corresponding SCSI disk rack and unlock all system and data disks not used
by the current Operating System instance.
See Preparing SCSI Disk Racks, on page 2-53.
FC Disk Racks
No action.

2. Select the first Linux RedHat domain in the Control pane scheme and click Power On to
power up the domain and associated hardware components.

3. Toggle the local / integrated console from the PAP unit display to MyOperations–1 or
MyOperations–2 display, as required. See Toggling the Local / Integrated Console
Display, on page 2-13.

4. Check Regional, Date/Time, and Time Zone settings.

5. Place the Linux RedHat CD–Rom in the corresponding drive. Setup is completed via the
Webmin administration tool:

a. Enter the Webmin URL:
http://<localhost>:10000. The Login to Webmin dialog box opens.

b. Enter the default User Name and Password, followed by Enter. The Webmin home
page opens.

User Name root

Password root

c. Click the Networking icon to open the Networking main page.
d. Click Network Configuration → Network Interfaces. In the Interfaces Activated at

Boot Time field, click Add a new interface to open the Create Bootup Interface
configuration page. Complete the required fields with the data supplied by the
Customer and click Create.

e. From the Interfaces Activated at Boot Time field, select the new interface. The Edit
Bootup Interface page opens. Check settings and click Save and Apply → Return
to network configuration.

f. Click Routing and Gateways to open the Routing and Gateways configuration
page. Complete the required fields with the data supplied by the Customer and click
Save → Return to network configuration.

g. Click DNS Client to open the DNS Client Options configuration page. Complete the
required fields with the data supplied by the Customer and click Save → Return to
network configuration.

h. Click Host Addresses → Add a new host address to open the Host and
Addresses configuration box. Complete the required fields with the data supplied by
the Customer and click Create → Return to host addresses list → Return to
network configuration → Return to index → System → Bootup and Shutdown to
create a new bootup and shutdown action.

i. From the action list, select Network to display the Edit Action page and click →
Restart Now → Return to action → Return to bootup and shutdown actions →
Return to index → Log Out to exit Webmin. Once setup is complete, the network is
activated.

6. Shut down the domain and associated hardware components by selecting the Shut
Down command in the Start Menu.

7. Toggle the local / integrated console from the domain display to the PAP unit display.
See Toggling the Local / Integrated Console Display, on page 2-13.

8. Update Domain Identity Management Parameters:
a. From the Customer Administrator PAM Tree, click Domains → Identities.
b. Select the corresponding Domain Identity and click Edit. The Edit Identity dialog

opens.
c. Complete the Network Name, IP Address, and URL fields with the data entered

during the setup completion procedure.
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9. Repeat steps 1 to 8 for each pre–installed Linux Redhat instance.

10.SCSI Disk Racks
Lock the disks unlocked before launching the setup completion procedure.

Novell  SuSe Setup
1. SCSI Disk Racks

Locate the corresponding SCSI disk rack and unlock all system and data disks not used
by the current Operating System instance.
See Preparing SCSI Disk Racks, on page 2-53.
FC Disk Racks
No action.

2. Select the first Linux SuSe domain in the Control pane scheme and click Power On to
power up the domain and associated hardware components.

3. Toggle the local / integrated console from the PAP unit display to MyOperations–1 or
MyOperations–2 display, as required. See Toggling the Local / Integrated Console
Display, on page 2-13.

4. Check Regional, Date/Time, and Time Zone settings.

5. Place the Linux SuSe CD–Rom in the corresponding drive. Setup is completed via the
Yast Control Center administration tool:

a. Type the default User Name and Password, followed by Enter.

User Name root

Password root

b. Enter yast2 (graphical mode) or yast (non–graphical mode) to open the Yast Control
Center main page.

 Note:
Use the <Tab> and <Arrow> keys to navigate through the menus.

c. Click Network/Basic → Network Card Configuration.
d. Select the required network card and click Configure.
e. From the Network Address Setup page, select the setup method and complete the

required fields with the data supplied by the Customer.
f. From the Details settings area, click Host name and name server. Complete the

required fields and click Next.
g. From the Details settings area, click Routing. Complete the required fields and click

Next to return to the Network Card Configuration page. Your network card is
displayed in the Already configured devices area.

h. Click Close to exit Yast Control Center. Once setup is complete, the network is
activated.

6. Shut down the domain and associated hardware components by selecting the Shut
Down command in the Start Menu.

7. Toggle the local / integrated console from the domain display to the PAP unit display.
See Toggling the Local / Integrated Console Display, on page 2-13.

8. Update Domain Identity Management Parameters:

a. From the Customer Administrator PAM Tree, click Domains → Identities.
b. Select the corresponding Domain Identity and click Edit. The Edit Identity dialog

opens.
c. Complete the Network Name, IP Address, and URL fields with the data entered

during the setup completion procedure.
9. Repeat steps 1 to 8 for each pre–installed Linux SuSE instance.

10.SCSI Disk Racks
Lock the disks unlocked before launching the setup completion procedure.
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NovaScale 6165 Server – Operating System Setup
An Operating System instance is pre–installed on each domain boot disk (EFI LUN):

0LU0 = LUN device located in Module0_DIB0 or connected to Module0_IOC0

0LU1 = LUN device located in Module0_DIB1 or connected to Module0_IOC1

0LU2 = LUN device located in Module1_DIB0 or connected to Module1_IOC0

0LU3 = LUN device located in Module1_DIB1 or connected to Module1_IOC1

According to Customer requirements, identical or different Operating System instances may
be pre–installed on each EFI LUN. Operating System setup must be completed for each
Operating System instance.

 Note:
In the screen shots, tables, and examples in this guide:

– MyOperationsScheme–xx is referred to as MyOperationsScheme

– MyOperations–xx–1 is referred to as MyOperations–1

– MyOperations–xx–2 is referred to as MyOperations–2

– MyOperations–xx–3 is referred to as MyOperations–3

– MyOperations–xx–4 is referred to as MyOperations–4

Before proceeding to complete setup on each domain:

1. From the Customer Administrator PAM Tree, click Domain Manager. 
MyOperations–1and MyOperations–2, MyOperations–3 and MyOperations–4
domains are displayed in the Control pane.

2. Check Operating System type for each domain:

Microsoft Windows or Linux  logo in the Domain Identities box.

3. Locate the corresponding CD–Rom drive:

MyOperations–1: Module0, IPD0

MyOperations–2: Module0, IPD1

MyOperations–3: Module1, IPD0

MyOperations–4: Module1, IPD1

4. Note KVM ports for each domain:

MyOperations–1: CSS0_Mod0_IO0

MyOperations–2: CSS0_Mod0_IO1

MyOperations–3: CSS0_Mod1_IO0

MyOperations–4: CSS0_Mod1_IO1

5. Check that the Customer has supplied the System and Networking data required to
complete setup and customize the system. See the Installation Setup Data tables in the
Read Me First document supplied on delivery.

To complete Operating System setup, see:

• Microsoft Windows Setup, on page 2-49

• Linux Redhat Setup, on page 2-50

• Novell SuSe Setup, on page 2-51
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Microsoft Windows Setup

 Warning: 
Most of the options selected and validated during the setup sequence can be
modified. However, special attention is to be paid when selecting and validating the
Licensing Mode (Per Seat / Per Server). If selected and validated, the “Per Server”
Licensing Mode option CAN be modified. If selected and validated, the “Per Seat”
Licensing Mode CANNOT be modified.

1. Check that the Microsoft Windows CD–Rom labeled “TO BE COMPLETED” is ready for
use and that the yellow sticker with the 25–character Microsoft Windows Product Key
required to complete setup is clearly visible inside the cabinet.

2. SCSI Disk Racks
Locate the corresponding SCSI disk rack and unlock all system and data disks not used
by the current Operating System instance.
See Preparing SCSI Disk Racks, on page 2-53.
FC Disk Racks
No action.

3. Select the first Microsoft Windows domain in the Control pane and click Power On to
power up the domain and associated hardware components.

4. Toggle the local / integrated console from the PAP unit display to MyOperations–1 or
MyOperations–2 or MyOperations–3 or MyOperations–4 display, as required. See
Toggling the Local / Integrated Console Display, on page 2-13.

5. Check Regional, Date/Time, and Time Zone settings under EFI.

6. The setup wizard is launched automatically and guides the Customer and the Customer
Service Engineer through the setup completion procedure (approximately 30 minutes).

Once setup is complete, Microsoft Windows shuts down, the system domain is rebooted
and the server configuration wizard is launched automatically.

 Note:
Server configuration is a Customer–specific task and is not performed by the Customer
Service Engineer during installation. Once the system has been fully installed, the Customer
Administrator may launch this wizard to configure and manage Server Roles.

7. Close the server configuration wizard.

8. Shut down the domain and associated hardware components by selecting the Shut
Down command in the Start Menu.

9. Toggle the local / integrated console from the domain display to the PAP unit display.
See Toggling the Local / Integrated Console Display, on page 2-13.

10.Update Domain Identity Management Parameters:

a. From the Customer Administrator PAM Tree, click Domains → Identities.

b. Select the corresponding Domain Identity and click Edit. The Edit Identity dialog
opens.

c. Complete the Network Name, IP Address, and URL fields with the data entered
during the setup completion procedure.

11.Repeat steps 1 to 10 for each pre–installed Microsoft Windows instance.

12.SCSI Disk Racks
Lock the disks unlocked before launching the setup completion procedure.
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Linux  RedHat Setup
1. SCSI Disk Racks

Locate the corresponding SCSI disk rack and unlock all system and data disks not used
by the current Operating System instance.
See Preparing SCSI Disk Racks, on page 2-53.
FC Disk Racks
No action.

2. Select the first Linux RedHat domain in the Control pane scheme and click Power On to
power up the domain and associated hardware components.

3. Toggle the local / integrated console from the PAP unit display to MyOperations–1 or
MyOperations–2 or MyOperations–3 or MyOperations–4 display, as required. See
Toggling the Local / Integrated Console Display, on page 2-13.

4. Check Regional, Date/Time, and Time Zone settings.

5. Place the Linux RedHat CD–Rom in the corresponding drive. Setup is completed via the
Webmin administration tool:

a. Enter the Webmin URL:
http://<localhost>:10000. The Login to Webmin dialog box opens.

b. Enter the default User Name and Password, followed by Enter. The Webmin home
page opens.

User Name root

Password root

c. Click the Networking icon to open the Networking main page.

d. Click Network Configuration → Network Interfaces. In the Interfaces Activated at
Boot Time field, click Add a new interface to open the Create Bootup Interface
configuration page. Complete the required fields with the data supplied by the
Customer and click Create.

e. From the Interfaces Activated at Boot Time field, select the new interface. The Edit
Bootup Interface page opens. Check settings and click Save and Apply → Return
to network configuration.

f. Click Routing and Gateways to open the Routing and Gateways configuration
page. Complete the required fields with the data supplied by the Customer and click
Save → Return to network configuration.

g. Click DNS Client to open the DNS Client Options configuration page. Complete the
required fields with the data supplied by the Customer and click Save → Return to
network configuration.

h. Click Host Addresses → Add a new host address to open the Host and
Addresses configuration box. Complete the required fields with the data supplied by
the Customer and click Create → Return to host addresses list → Return to
network configuration → Return to index → System → Bootup and Shutdown to
create a new bootup and shutdown action.

i. From the action list, select Network to display the Edit Action page and click →
Restart Now → Return to action → Return to bootup and shutdown actions →
Return to index → Log Out to exit Webmin. Once setup is complete, the network is
activated.

6. Shut down the domain and associated hardware components by selecting the Shut
Down command in the Start Menu.

7. Toggle the local / integrated console from the domain display to the PAP unit display.
See Toggling the Local / Integrated Console Display, on page 2-13.

8. Update Domain Identity Management Parameters:
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a. From the Customer Administrator PAM Tree, click Domains → Identities.
b. Select the corresponding Domain Identity and click Edit. The Edit Identity dialog

opens.
c. Complete the Network Name, IP Address, and URL fields with the data entered

during the setup completion procedure.
9. Repeat steps 1 to 8 for each pre–installed Linux Redhat instance.

10.SCSI Disk Racks
Lock the disks unlocked before launching the setup completion procedure.

Novell  SuSe Setup
1. SCSI Disk Racks

Locate the corresponding SCSI disk rack and unlock all system and data disks not used
by the current Operating System instance.
See Preparing SCSI Disk Racks, on page 2-53.
FC Disk Racks
No action.

2. Select the first Linux SuSe domain in the Control pane scheme and click Power On to
power up the domain and associated hardware components.

3. Toggle the local / integrated console from the PAP unit display to MyOperations–1 or
MyOperations–2 or MyOperations–3 or MyOperations–4 display, as required. See
Toggling the Local / Integrated Console Display, on page 2-13.

4. Check Regional, Date/Time, and Time Zone settings.

5. Place the Linux SuSe CD–Rom in the corresponding drive. Setup is completed via the
Yast Control Center administration tool:

a. Type the default User Name and Password, followed by Enter.

User Name root

Password root

b. Enter yast2 (graphical mode) or yast (non–graphical mode) to open the Yast Control
Center main page.

 Note:
Use the <Tab> and <Arrow> keys to navigate through the menus.

c. Click Network/Basic → Network Card Configuration.

d. Select the required network card and click Configure.

e. From the Network Address Setup page, select the setup method and complete the
required fields with the data supplied by the Customer.

f. From the Details settings area, click Host name and name server. Complete the
required fields and click Next.

g. From the Details settings area, click Routing. Complete the required fields and click
Next to return to the Network Card Configuration page. Your network card is
displayed in the Already configured devices area.

h. Click Close to exit Yast Control Center. Once setup is complete, the network is
activated.

6. Shut down the domain and associated hardware components by selecting the Shut
Down command in the Start Menu.

7. Toggle the local / integrated console from the domain display to the PAP unit display.
See Toggling the Local / Integrated Console Display, on page 2-13.

8. Update Domain Identity Management Parameters:

a. From the Customer Administrator PAM Tree, click Domains → Identities.
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b. Select the corresponding Domain Identity and click Edit. The Edit Identity dialog
opens.

c. Complete the Network Name, IP Address, and URL fields with the data entered
during the setup completion procedure.

9. Repeat steps 1 to 8 for each pre–installed Linux SuSE instance.

10.SCSI Disk Racks
Lock the disks unlocked before launching the setup completion procedure.
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Preparing SCSI Disk Racks

  Important: 
Only the system / spare disks used by the current Operating System instance must
be accessible. Optional data disk drives must be unlocked, as shown in the following
figures.

SJ–0812 SCSI JBOD Disk Racks
Two domains share a disk rack with system and optional data disks. System and spare
disks are located in the same slots in each disk rack.

MyOperations–1 and MyOperations–2 share the same disk rack. MyOperations–1 is
connected to the SCSI HBA adapter located in Module0, IOB0, Slot 01 (Port A) and
MyOperations–2 is connected to the SCSI HBA adapter located in Module0, IOB1, Slot 01
(Port A).

MyOperations–3 and MyOperations–4 share the same disk rack. MyOperations–3 is
connected to the SCSI HBA adapter located in Module1, IOB0, Slot 01 (Port A) and
MyOperations–4 is connected to the SCSI HBA adapter located in Module1, IOB1, Slot 01
(Port A).

OS Disk Optional Data Disks
LEAVE

OS Disk
LEAVE

Spare Disk
LEAVE

Optional Data Disks

Spare Disk OS Disk

OS Disk
UNLOCK UNLOCKLEAVE

LEAVELEAVE

Figure 49. SJ–0812 SCSI JBOD disk racks – all domains
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SR–0812 SCSI RAID Disk Racks
Each domain has its own disk rack with system and optional data disks. System and spare
disks are located in the same slots in each disk rack.

MyOperations–1 disk rack is connected to the SCSI HBA adapter located in Module0,
IOB0, Slot 01 (Port A).

MyOperations–2 disk rack is connected to the SCSI HBA adapter located in Module0,
IOB1, Slot 01 (Port A).

MyOperations–3 disk rack is connected to the SCSI HBA adapter located in Module1,
IOB0, Slot 01 (Port A).

MyOperations–4 disk rack is connected to the SCSI HBA adapter located in Module1,
IOB1, Slot 01 (Port A).

OS Disk Optional Data Disks
LEAVE UNLOCK

OS Disk

LEAVE
Spare Disk

LEAVE
Optional Data Disks

UNLOCK

Figure 50. SR–0812 SCSI RAID disk racks – all domains

SJ–0812 SCSI Extension Disk Racks

Optional Data Disks

UNLOCK

Optional Data Disks

UNLOCK

Figure 51. SJ–0812 extension disk location (data) – All domains

Unlocking Disk Drives

1. Before proceeding to complete Operating System setup, use a Torx T10 screwdriver to
open the optional disk drive anti–tamper lock, the indicator becomes black.

2. Press the carrier latch to release the handle.

3. Wait 30 seconds.

Locking Disk Drives

1. Once Operating System setup is complete, use a Torx T10 screwdriver to close the
optional disk drive anti–tamper lock, the indicator becomes red.

2. Check drive LED status. If the lock is correctly closed, both LEDs should be lit.
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Connecting the Server to the Enterprise LAN

  Important: 
Extra cable lengths of 1.5  meters are required for maintenance. These extra cable
lengths must be absorbed in the plenum space under the cabinet.

At the Customer’s request, server domains can be connected to the Enterprise LAN via the
IOL board for remote operation.

LAN port

Figure 52. 10/100/1000 Mb/s LAN port

To connect server domain(s) to the Enterprise LAN:

NovaScale 5xx5 Servers

1. Locate the Ethernet 10/100/1000 Mb/s LAN RJ45 port on the Master IOL board.

2. Connect the network cable equipped with an RJ45 connector to the Master IOL board
LAN port. Network connections are detected automatically.

3. Carefully route network cables through the cable inlet at the base of the cabinet.

NovaScale 6xx5 Servers

1. Locate the corresponding IOL board:

MyOperations–1: Module0, IOC0, IOL0

MyOperations–2: Module0, IOC1, IOL1

MyOperations–3: Module1, IOC0, IOL0

MyOperations–4: Module1, IOC1, IOL1

2. Locate the Ethernet 10/100/1000 Mb/s LAN RJ45 ports on each IOL board.

3. Connect the network cables equipped with an RJ45 connector to the IOL board LAN
ports. Network connections are detected automatically.

4. Carefully route network cables through the cable inlet at the base of the cabinet.
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Connecting the USB Modem and External Devices

Connecting the USB Modem
If the Customer’s maintenance contract includes the Autocall feature, connect the USB
modem as follows:

1. Connect the modem cable equipped with a USB connector to the USB port on the rear of
the PAP unit.

2. Route the line modem cable equipped with an RJ11 connector through the cable cut–out
at the base of the cabinet.

3. Connect the modem cable to the line port on the rear of the USB modem. 
See the NovaScale 5000/6000 Series Cabling Guide, 86 A1 34ER.

 Note:
Modem cable connectors differ from country to country. Customers are to provide the RJ11
adapter required to comply with national standards.

Connecting External Storage Peripherals
The Customer may now proceed to connect any external storage peripherals (tape libraries,
external disk subsystems, ...) required for use with the server.
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Testing Network Connections
Network connections to the PAP unit and to server domains can be tested from a remote
workstation connected to the same network by launching a PING command.

 Note:
PAP unit setup is described in Completing PAP Unit Configuration, on page 2-28.

Windows [  Workstation

1. Click Start → Run and enter cmd.

2. Enter ping <IP_address>, (where <IP_address> is the IP address allocated to the PAP
unit or server domain during setup).

Linux [  Workstation

1. Open a Shell command window.

2. Enter ping <IP_address>, (where <IP_address> is the IP address allocated to the PAP
unit or server domain during setup).

 Note:
If the PAP unit or server domain does not reply to the PING command, check network
connections and configuration:

– IP address,
– DHCP,
– Network mask,
– Network card driver.

Testing Autocalls
If the Customer’s maintenance contract includes the Autocall feature, check the connection
between the PAP unit and the Remote Maintenance Center Server as follows:

1. From the PAM home page, click Configuration Tasks → Autocalls.

2. Click the Test Autocall button in the toolbar. A dialog appears to confirm that the
autocall has been sent to the Remote Maintenance Center.

Completing the PAM Installation Intervention Report
Once system operation has been checked, an Installation Intervention Report must be
completed. If the Customer’s maintenance contract includes the Autocall feature, this report
will be automatically transferred to the Remote Maintenance Center.

 Note:
If the Customer’s maintenance contract does not include the Autocall feature, manually
complete the Installation Work Order provided in the Open Me First box. The intervention
report is sent as an event message and stored in the PAM History directory. See the User’s
Guide.

1. From the PAM home page, click Servicing Tools → Intervention Report.

2. Complete the Intervention Report.

3. Click Send.  If the Customer’s maintenance contract includes the Autocall feature, the
report is automatically transferred to the Remote Maintenance Center. If the Customer’s
maintenance contract does not include the Autocall feature, the report is sent as an
event message and stored in the PAM History directory.
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Renaming a Central Subsystem

 Note:
Central Subsystem configuration is reserved for Customer Service Engineers.

The Central Subsystem may be renamed to suit Customer requirements. Changes to
Central Subsystem configuration entail removing the existing Central Subsystem from the
configuration and adding a new Central Subsystem to the configuration with the name
chosen by the Customer.

NovaScale 6xx5 Servers

Default Domain Schemes cannot be used by the new Central Subsystem and have to be
re–defined. Default Domain Identities can still be used and do not have to be re–defined.

See Redefining the Default Scheme, on page 2-60.

Removing / Adding a Central Subsystem
1. From the Support Administrator PAM Tree, click Domain Manager to check that all

domains are INACTIVE. If a domain is ACTIVE, request the Customer to power down
the domain. See Powering Up / Down Server Domains, on page 2-14.

2. Click Configuration Tasks → Central Subsystem. The Central Subsystem control
pane opens.

3. Select the Central Subsystem and click Remove. A dialog opens requesting you to
confirm removal.

4. Click OK to remove the Central Subsystem.

5. Click New. The Add Central Subsystem dialog appears.

Figure 53. Central Subsystem control pane
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6. Enter the Central Subsystem name supplied by the Customer and the hardware
hexadecimal identifier (between 0 and F as indicated on the PMB CSS code wheel).

 Note:
Up to 16 CSS modules can be linked, via a PMB to the PAP unit. PMB code wheels
allow the identification of each cabinet and each CSS module in the Customer’s
configuration.

Example of PMB code wheel settings for a system with 3 cabinets, each containing 2
modules:

Cabinet 1 Cabinet 2 Cabinet 3

Cabinet Hexadecimal Code (0 to F) 0 1 2

CSS Module_0 Hexadecimal Code (0 to F) 0 0 0

CSS Module_1 Hexadecimal Code (0 to F) 1 1 1

Table 5. PMB code wheel settings – multiple server configuration example

7. Click OK. You are requested to update the PAM tree.

8. Click the PAM tree  Refresh button. The new Central Subsystem is added to the
pool of resources available for domain management and configuration and appears in
the PAM tree under the Hardware Monitor node.

Central Subsystem

Functional status icon & CSS availability status bar

Figure 54. Central Subsystem node

9. Check server status – system functional status icon and CSS availability status bar
green in the Status pane. See Figure 27.Status pane, on page 2-10.

 Note:
PAM software allocates a PUID (PAM Universal / Unique Identifier) to each hardware /
software object to guarantee unambiguous identification.

The PUID for a Central Subsystem is:
PAM:/CELLSBLOCK_<NAME>, 
where <NAME> is the name allocated by the Customer when the Central Subsystem is
declared.

The PUID for the Central Subsystem in the example shown above is:
PAM:/CELLSBLOCK_MYSERVER

This PUID is used for the creation of Domain Schemes.
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Redefining the Default Scheme (NovaScale 6085 Server)

 Notes:

• xx in the default Scheme and domain names represents the Central Subsystem HW
identifier (from 00 to 16). For further details, refer to Checking PMB Code Wheel Settings,
on page 2-4.

• In the screen shots, tables, and examples in this guide:

– MyOperationsScheme–xx is referred to as MyOperationsScheme

– MyOperations–xx–1 is referred to as MyOperations–1

– MyOperations–xx–2 is referred to as MyOperations–2

• In the screen shots in this guide, an instance of Microsoft Windows is pre–installed on
MyOperations–1 and an instance of Linux is pre–installed on MyOperations–2.

To redefine the default scheme:

1. From the Customer Administrator PAM Tree, click Configuration Tasks → Domains →
Schemes to open the Schemes Management pane.

2. Select MyOperationsScheme click Delete.

3. Click New to open the Scheme Creation dialog and complete the fields as follows:

Field Value

Scheme MyOperationsScheme

Description Default scheme for <MyServer>*

* <MyServer> = New Central Subsystem name given by the Customer

Figure 55. Scheme creation page
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4. Click Central Subsystem → Add to select the previously declared Central Subsystem.
The Central Subsystem Configuration dialog opens.

Figure 56. Central Subsystem Configuration dialog

5. Check that the Central Subsystem is highlighted and select 2 in the Number of Parts
dropdown list.

6. Click OK to return to the Scheme Management dialog. Status icons are red because
Domain Identities and EFI LUNs are required to complete domain configuration.

Figure 57. Scheme Management dialog

7. Double click the empty D1 Domain Identities field and select MyOperations–1 from the
list of available identities.

8. Double click the empty D1 EFI LUNs field and select the required LUN from the list of
available EFI LUNs. Domain D1 configuration is complete and the corresponding Status
icon turns green.
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9. Repeat Steps 7 and 8 for D2, taking care to select MyOperations–2 and the required
LUN from the lists of available identities and EFI LUNs:

All Status icons turn green.

Figure 58. Scheme Management dialog

10.Click Save. The re–defined default domain scheme is now available for domain
management.

 Note:
For further details about domain configuration, see Configuring Domains in the User’s
Guide.
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Redefining the Default Scheme (NovaScale 6165 Server)

 Notes:

• xx in the default Scheme and domain names represents the Central Subsystem HW
identifier (from 00 to 16). For further details, refer to Checking PMB Code Wheel Settings,
on page 2-4.

• In the screen shots, tables, and examples in this guide:

– MyOperationsScheme–xx is referred to as MyOperationsScheme

– MyOperations–xx–1 is referred to as MyOperations–1

– MyOperations–xx–2 is referred to as MyOperations–2

– MyOperations–xx–3 is referred to as MyOperations–3

– MyOperations–xx–4 is referred to as MyOperations–4

• In the screen shots in this guide, an instance of Microsoft Windows is pre–installed on
MyOperations–1 and MyOperations–3 and an instance of Linux is pre–installed on
MyOperations–2 and MyOperations–4.

To redefine the default scheme:

1. From the Customer Administrator PAM Tree, click Configuration Tasks → Domains →
Schemes to open the Schemes Management pane.

2. Select MyOperationsScheme click Delete.

3. Click New to open the Scheme Creation dialog and complete the fields as follows:

Field Value

Scheme MyOperationsScheme

Description Default scheme for <MyServer>*

* <MyServer> = New Central Subsystem name given by the Customer

Figure 59. Scheme creation page
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4. Click Central Subsystem → Add to select the previously declared Central Subsystem.
The Central Subsystem Configuration dialog opens.

Figure 60. Central Subsystem Configuration dialog

5. Check that the Central Subsystem is highlighted and select 4 in the Number of Parts
dropdown list.

6. Click OK to return to the Scheme Management dialog. Status icons are red because
Domain Identities and EFI LUNs are required to complete domain configuration.
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Figure 61. Scheme Management dialog

7. Double click the empty D1 Domain Identities field and select MyOperations–1 from the
list of available identities.

8. Double click the empty D1 EFI LUNs field and select the required LUN from the list of
available EFI LUNs. Domain D1 configuration is complete and the corresponding Status
icon turns green.

9. Repeat Steps 7 and 8 for the other domains, taking care to select from the lists of
available identities and EFI LUNs:

– MyOperations–2 and the required LUN for D2
– MyOperations–3 and the required LUN for D3
– MyOperations–4 and the required LUN for D4

All the Status icons turn green.

Figure 62. Scheme Management dialog

10.Click Save. The re–defined default domain scheme is now available for domain
management.
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 Note:
For further details about domain configuration, see Configuring Domains in the User’s
Guide.
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Setting up PAP Unit Users
The Customer Administrator should now set up at least one Customer Administrator and
one Customer Operator user account to ensure controlled access to the PAP unit.

The Microsoft Windows operating system pre–installed on the PAP unit provides standard
security features for controlling access to applications and resources. PAM software security
is based on Windows)  user management and you are advised to give Windows)

administrator rights to at least one member of the PAP Customer Administrator user group.
For further details about user management, refer to the Microsoft Windows documentation
on the Bull NovaScale Server System Resource CD.

 Note:
You are advised to change the temporary Administrator password (administrator) used for
setup purposes and to maintain a detailed record of authorized users.

Predefined PAP User Groups
For optimum security and flexibility, the Microsoft Windows software environment is
delivered with two predefined Customer user groups:

Pap_Customer_Administrators Group (CA)

This group is designed for customer representatives responsible for the overall
management, configuration, and operation of the system. Members of the Customer
Administrator group are allowed to configure and administrate the server and have full
access to the PAM Domain Manager, Hardware Monitor, History Manager and
Configuration Tasks menus, as shown in Table 6.

Pap_Customer_Operators (CO)

This group is designed for customer representatives responsible for the daily operation of
the system. Members of the Customer Operator group are allowed to operate the server
and have full access to the Domain Manager menu and partial access to the History
Manager menu, as shown in Table 6.

 Notes:

• Group membership also conditions which Event Messages a user will receive via the
PAM Web interface. See Setting up Event Subscriptions, in the User’s Guide.

• The predefined Customer user groups have been designed to suit the needs of most
Administrator and Operators. Contact your Customer Service Engineer if you require a
customized user group.

 Warning: 
The two predefined Support user groups:

– Pap_Support_Administrators

– Pap_Support_Operators

are reserved EXCLUSIVELY for authorized Customer Service Engineers in charge
of monitoring, servicing, and upgrading the system.
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PAM Tools Associated Actions CA CO

Domain Manager

Load/delete domains

Power on/off/reset domains

View/modify domain settings

View domain status

View domain resources

View BIOS info

View BIOS version

View loaded BIOS image

View power logs

View request logs

Request a system dump

X

X

X

X

X

X

X

X

X

X

X

X

X

X

X

X

X

X

X

X

X

X

Hardware Monitor

View hardware functional/presence status

View detailed hardware status information

Use the hardware Search engine

Exclude/include hardware components

View current PAM Web site user information

View PAM version information

X

X

X

X

X

X

History Manager

View system history files and messages

Manually archive system history files

View/delete system history archives

View user history files

Manually archive user history files

View/delete user history archives

X

X

X

X

X

X

X

X

X

Configuration Tasks

View/modify customer information

Modify the system history automatic archiving policy

Create/modify/delete domain schemes and identities

Modify domain schemes and identities

Create/delete user histories

Modify user history automatic archiving policy

Customize the event messaging system

View/ modify PAM parameters

Display/modify autocall parameters

X

X

X

X

X

X

X

X

X

Status Pane

View/acknowledge WEB event messages

Check system functional status

Check CSS availability

X

X

X

X

X

X

Table 6. User access to PAM features

CA = Customer Administrator
CO = Customer Operator
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Backing Up and Restoring PAM Configuration Files
The Customer Administrator should now set up an automatic backup task via the Microsoft
Windows Task Scheduler to save PAM configuration data to a removable media or to a
network directory for rapid restoration in the event of a PAP unit failure.

To ensure carefree, reliable and regular configuration data backup, the Bull NovaScale
Server Resource CD contains two scripts, PamBackupData.js and PamRestoreData.js,
that can be scheduled to run via the Microsoft Windows Task Scheduler to save and
restore PAM configuration data.

 Notes:

• PAM configuration data is automatically saved to the default PAM Site Data directory on
the PAP unit:

<WinDrive>:\Program Files\BULL\PAM\PAMSiteData\<DataCompatibilityRelease>

• The PamBackupData.js and PamRestoreData.js scripts are stored in the PAM Site
Data directory on the PAP unit:

<WinDrive>:\Program Files\BULL\PAM\PAMSiteData\ReleaseData\Utilities

Backing Up PAM Configuration Files
To create a Microsoft Windows automatic backup task:

1. Select or create the local or network directory to be used for saving configuration data,
e.g. <MyPamBackupDirectory>.

2. Create a local directory for the PamBackupData.js and PamRestoreData.js script files,
e.g. <MyPamBackupTools>.

3. Copy the PamBackupData.js and PamRestoreData.js script files into the
<MyPamBackupTools> directory.

4. Create a Text File and enter the following command line:

Cscript PamBackupData.js <MyPamBackupDirectory>

5. Save the Text File as a batch file with a .BAT extension,
e.g. <MyPamBackupCommand>.bat.

6. Click Control Panel → Scheduled Tasks →  Add Scheduled Task to open the Task
Scheduler wizard and follow the instructions. PAM configuration data will be
automatically saved at the interval indicated in the wizard.
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Restoring PAM Configuration Data

 Warning: 
The same PAM software release must be deployed on the PAP unit and on the backup
PC to allow data restoration. 
PAM releases use the same data directory to ensure configuration consistency.
Before activating / re–activating a PAM Version, ensure that the
<DataCompatibilityRelease> level of deployed releases is compatible.

To restore PAM configuration data:

1. If required, install the same PAM software release on the backup PC as on the PAP unit.
See Deploying a New PAM Release and Activating a PAM Version in the User’s Guide.

2. From the Microsoft Windows desktop, open a command window. Browse to the
<MyPamBackupTools> directory containing the script files and enter the following
command line:

Cscript PamRestoreBackupData.js <MyPamBackupDirectory>

Saved PAM configuration data is restored.
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Appendix A.  Specifications

• NovaScale 5085 Server Specifications, on page A-2

• NovaScale 5165 Server Specifications, on page A-4

• NovaScale 6085 Server Specifications, on page A-6

• NovaScale 6165 Server Specifications, on page A-8
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NovaScale 5085 Server Specifications
NovaScale 5085 Servers are delivered rack–mounted in 40U or 19U cabinets.

The following web site may be consulted for general site preparation information:
http://www.cs.bull.net/aise.

Cabinet Dimensions / Weight

Unpacked Packed

1300H

Height: 195.5 cm (77.0 in)

Width:   60.0 cm (23.6 in)

Depth: 129.5 cm (51.0 in)

Weight (max): 943 kg (2079 lb)

1300H

Height:  200.0 cm (78.7 in)

Width:   80.0 cm (31.5 in)

Depth: 140.0 cm (55.1 in)

Weight (max): 973 kg (2145 lb)

1300L

Height: 103.5 cm (40.7 in)

Width:   60.0 cm (23.6 in)

Depth: 129.5 cm (51.0 in)

Weight (max.): 478 kg (1054 lb)

1300L

Height: 108.0 cm (42.5in)

Width:   80.0 cm (31.5 in)

Depth: 140.0 cm (55.1 in)

Weight (max.): 508 kg (1120 lb)

Service Clearance

Front

Rear

Side (free side)

150 cm

100 cm

100 cm

Operating Limits

Dry bulb temperature range

Relative humidity (non–condensing)

Max. wet bulb temperature

Moisture  content

Pressure / Elevation

+15°C  to  +30°C  (+59°F to +86°F) 

Gradient 5°C/h (41°F/h)

35 to 60%  (Gradient 5%/h)

+24°C   (+75.2°F)

0.019 kg water/kg dry air

Sea level < 2500 m

Optimum Operational Reliability

Temperature

Hygrometry

+ 22°C (+ 3°C) (+ 72°F (+ 5°F)

50% (+  5%)

Non–Operating Limits

Dry bulb temperature range

Relative humidity (non–condensing)

Max. wet bulb temperature

Moisture  content

+5°C  to  +50°C   (+41°F to +122°F)

Gradient 25°C/h  (77°F/h)

5 to 95%  (Gradient 30%)

+28°C   (+82.4°F)

0.024 kg water/kg dry air

Shipping Limits

Dry bulb temperature range 

Relative humidity (non–condensing)

–35°C  to  +65°C (–31°F to +149°F)

Gradient 25°C/h  (77°F/h)

5 to 95% Gradient 30%/h

Acoustic Power at Room Temperature +20° C (+68° F)

System Running System Idle

Lw(A) 6.3 Bels Lw(A) 6.1 Bels
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Power Cables

PDU–2–4–M–32A

AC (32A)

Cable type

Connector type

1 per PDU

3 x AWG10 ( 3 x 6 mm2 / #10US)

IEC60309–32A

It is mandatory for power lines and terminal boxes to be located within the imme-
diate vicinity of the system and to be easily accessible. Each power line must be
connected to a separate, independent electrical panel and bipolar circuit breaker.
PDUs require an extra cable length of 1.5 meters for connection inside the cabinet.

Electrical Specifications
 (power supplies are auto–sensing and auto–ranging)

Current draw

Power consumption

Thermal dissipation

11 A max. at 200 VAC input

2400 VA per full CSS module

2400 W / 8190 BTU per full CSS module

Europe

Nominal voltage

Voltage range

Frequency

230 VAC (Phase / Neutral)

207 – 244 VAC

50 Hz � 1%

United States of America

Nominal voltage

Voltage range

Frequency

208 VAC (Phase / Neutral)

182 – 229 VAC

60 Hz � 0.3%

Japan

Nominal voltage

Voltage range

Frequency

200 VAC (Phase / Neutral)

188 – 212 VAC

60 Hz � 0.2%

Brazil

Nominal voltage

Voltage range

Frequency

220 VAC (Phase / Neutral)

212 – 231 VAC

60 Hz � 2%

Breaker Protection (Mains Power)

PDU–2–4–M–32A

Maximum inrush current

32A Curve C

210A / per quarter period

Table 7. NovaScale 5085 Server specifications



A-4 Installation Guide

NovaScale 5165 Server Specifications
NovaScale 5165 Servers are delivered rack–mounted in 40U or 19U cabinets.

Cabinet Dimensions / Weight

Unpacked Packed

1300H

Height: 195.5 cm (77.0 in)

Width:   60.0 cm (23.6 in)

Depth: 129.5 cm (51.0 in)

Weight (max): 943 kg (2079 lb)

1300H

Height:  200.0 cm (78.7 in)

Width:   80.0 cm (31.5 in)

Depth: 140.0 cm (55.1 in)

Weight (max): 973 kg (2145 lb)

1300L

Height: 103.5 cm (40.7 in)

Width:   60.0 cm (23.6 in)

Depth: 129.5 cm (51.0 in)

Weight (max.): 478 kg (1054 lb)

1300L

Height: 108.0 cm (42.5in)

Width:   80.0 cm (31.5 in)

Depth: 140.0 cm (55.1 in)

Weight (max.): 508 kg (1120 lb)

Service Clearance

Front

Rear

Side (free side)

150 cm

100 cm

100 cm

Operating Limits

Dry bulb temperature range

Relative humidity (non–condensing)

Max. wet bulb temperature

Moisture  content

Pressure / Elevation

+15°C  to  +30°C  (+59°F to +86°F) 

Gradient 5°C/h (41°F/h)

35 to 60%  (Gradient 5%/h)

+24°C   (+75.2°F)

0.019 kg water/kg dry air

Sea level < 2500 m

Optimum Operational Reliability

Temperature

Hygrometry

+ 22°C (+ 3°C) (+ 72°F (+ 5°F)

50% (+  5%)

Non–Operating Limits

Dry bulb temperature range

Relative humidity (non–condensing)

Max. wet bulb temperature

Moisture  content

+5°C  to  +50°C   (+41°F to +122°F)

Gradient 25°C/h  (77°F/h)

5 to 95%  (Gradient 30%)

+28°C   (+82.4°F)

0.024 kg water/kg dry air

Shipping Limits

Dry bulb temperature range

Relative humidity (non–condensing)

–35°C  to  +65°C (–31°F to +149°F)

Gradient 25°C/h  (77°F/h)

5 to 95% Gradient 30%/h

Acoustic Power at Room Temperature +20° C (+68° F)

System Running System Idle

Lw(A) 6.3 Bels Lw(A) 6.1 Bels
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Power Cables

PDU–2–4–M–32A

AC (32A)

Cable type

Connector type

1 per PDU

3 x AWG10 (3 x 6 mm2 / #10US)

IEC60309–32A

It is mandatory for power lines and terminal boxes to be located within the imme-
diate vicinity of the system and to be easily accessible. Each power line must be
connected to a separate, independent electrical panel and bipolar circuit breaker.
PDUs require an extra cable length of 1.5 meters for connection inside the cabinet.

Electrical Specifications
 (power supplies are auto–sensing and auto–ranging)

Current draw

Power consumption

Thermal dissipation

11 A max. at 200 VAC input

2400 VA per full CSS module

2400 W / 8190 BTU per full CSS module

Europe

Nominal voltage

Voltage range

Frequency

230 VAC (Phase / Neutral)

207 – 244 VAC

50 Hz � 1%

United States of America

Nominal voltage

Voltage range

Frequency

208 VAC (Phase / Neutral)

182 – 229 VAC

60 Hz � 0.3%

Japan

Nominal voltage

Voltage range

Frequency

200 VAC (Phase / Neutral)

188 – 212 VAC

60 Hz � 0.2%

Brazil

Nominal voltage

Voltage range

Frequency

220 VAC (Phase / Neutral)

212 – 231 VAC

60 Hz � 2%

Breaker Protection (Mains Power)

PDU–2–4–M–32A

Maximum inrush current

32A Curve C

210A / per quarter period

Table 8. NovaScale 5165 Server specifications
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NovaScale 6085 Server Specifications
NovaScale 6085 Servers are delivered rack–mounted in 40U or 19U cabinets.

The following web site may be consulted for general site preparation information:
http://www.cs.bull.net/aise.

Cabinet Dimensions / Weight

Unpacked Packed

1300H

Height: 195.5 cm (77.0 in)

Width:   60.0 cm (23.6 in)

Depth: 129.5 cm (51.0 in)

Weight (max): 943 kg (2079 lb)

1300H

Height:  200.0 cm (78.7 in)

Width:   80.0 cm (31.5 in)

Depth: 140.0 cm (55.1 in)

Weight (max): 973 kg (2145 lb)

1300L

Height: 103.5 cm (40.7 in)

Width:   60.0 cm (23.6 in)

Depth: 129.5 cm (51.0 in)

Weight (max.): 478 kg (1054 lb)

1300L

Height: 108.0 cm (42.5in)

Width:   80.0 cm (31.5 in)

Depth: 140.0 cm (55.1 in)

Weight (max.): 508 kg (1120 lb)

Service Clearance

Front

Rear

Side (free side)

150 cm

100 cm

100 cm

Operating Limits

Dry bulb temperature range

Relative humidity (non–condensing)

Max. wet bulb temperature

Moisture  content

Pressure / Elevation

+15°C  to  +30°C  (+59°F to +86°F) 

Gradient 5°C/h (41°F/h)

35 to 60%  (Gradient 5%/h)

+24°C   (+75.2°F)

0.019 kg water/kg dry air

Sea level < 2500 m

Optimum Operational Reliability

Temperature

Hygrometry

+ 22°C (+ 3°C) (+ 72°F (+ 5°F)

50% (+  5%)

Non–Operating Limits

Dry bulb temperature range

Relative humidity (non–condensing)

Max. wet bulb temperature

Moisture  content

+5°C  to  +50°C   (+41°F to +122°F)

Gradient 25°C/h  (77°F/h)

5 to 95%  (Gradient 30%)

+28°C   (+82.4°F)

0.024 kg water/kg dry air

Shipping Limits

Dry bulb temperature range

Relative humidity (non–condensing)

–35°C  to  +65°C (–31°F to +149°F)

Gradient 25°C/h  (77°F/h)

5 to 95% Gradient 30%/h

Acoustic Power at Room Temperature +20° C (+68° F)

System Running System Idle

Lw(A) 6.3 Bels Lw(A) 6.1 Bels
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Power Cables

PDU–2–4–M–32A

AC (32A)

Cable type

Connector type

1 per PDU

3 x AWG10 (3 x 6 mm2 / #10US)

IEC60309–32A

It is mandatory for power lines and terminal boxes to be located within the imme-
diate vicinity of the system and to be easily accessible. Each power line must be
connected to a separate, independent electrical panel and bipolar circuit breaker.
PDUs require an extra cable length of 1.5 meters for connection inside the cabinet.

Electrical Specifications
 (power supplies are auto–sensing and auto–ranging)

Current draw

Power consumption

Thermal dissipation

11 A max. at 200 VAC input

2400 VA per full CSS module

2400 W / 8190 BTU per full CSS module

Europe

Nominal voltage

Voltage range

Frequency

230 VAC (Phase / Neutral)

207 – 244 VAC

50 Hz � 1%

United States of America

Nominal voltage

Voltage range

Frequency

208 VAC (Phase / Neutral)

182 – 229 VAC

60 Hz � 0.3%

Japan

Nominal voltage

Voltage range

Frequency

200 VAC (Phase / Neutral)

188 – 212 VAC

60 Hz � 0.2%

Brazil

Nominal voltage

Voltage range

Frequency

220 VAC (Phase / Neutral)

212 – 231 VAC

60 Hz � 2%

Breaker Protection (Mains Power)

PDU–2–4–M–32A

Maximum inrush current

32A Curve C

210A / per quarter period

Table 9. NovaScale 6085 Server specifications
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NovaScale 6165 Server Specifications
NovaScale 6165 Servers are delivered rack–mounted in 40U or 19U cabinets.

The following web site may be consulted for general site preparation information:
http://www.cs.bull.net/aise.

Cabinet Dimensions / Weight

Unpacked Packed

1300H

Height: 195.5 cm (77.0 in)

Width:   60.0 cm (23.6 in)

Depth: 129.5 cm (51.0 in)

Weight (max): 943 kg (2079 lb)

1300H

Height:  200.0 cm (78.7 in)

Width:   80.0 cm (31.5 in)

Depth: 140.0 cm (55.1 in)

Weight (max): 973 kg (2145 lb)

1300L

Height: 103.5 cm (40.7 in)

Width:   60.0 cm (23.6 in)

Depth: 129.5 cm (51.0 in)

Weight (max.): 478 kg (1054 lb)

1300L

Height: 108.0 cm (42.5in)

Width:   80.0 cm (31.5 in)

Depth: 140.0 cm (55.1 in)

Weight (max.): 508 kg (1120 lb)

Service Clearance

Front

Rear

Side (free side)

150 cm

100 cm

100 cm

Operating Limits

Dry bulb temperature range

Relative humidity (non–condensing)

Max. wet bulb temperature

Moisture  content

Pressure / Elevation

+15°C  to  +30°C  (+59°F to +86°F) 

Gradient 5°C/h (41°F/h)

35 to 60%  (Gradient 5%/h)

+24°C   (+75.2°F)

0.019 kg water/kg dry air

Sea level < 2500 m

Optimum Operational Reliability

Temperature

Hygrometry

+ 22°C (+ 3°C) (+ 72°F (+ 5°F)

50% (+  5%)

Non–Operating Limits

Dry bulb temperature range

Relative humidity (non–condensing)

Max. wet bulb temperature

Moisture  content

+5°C  to  +50°C   (+41°F to +122°F)

Gradient 25°C/h  (77°F/h)

5 to 95%  (Gradient 30%)

+28°C   (+82.4°F)

0.024 kg water/kg dry air

Shipping Limits

Dry bulb temperature range

Relative humidity (non–condensing)

–35°C  to  +65°C (–31°F to +149°F)

Gradient 25°C/h  (77°F/h)

5 to 95% Gradient 30%/h

Acoustic Power at Room Temperature +20° C (+68° F)

System Running System Idle

Lw(A) 6.3 Bels Lw(A) 6.1 Bels
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Power Cables

PDU–2–4–M–32A

AC (32A)

Cable type

Connector type

1 per PDU

3 x AWG10 (3 x 6 mm2 / #10US)

IEC60309–32A

It is mandatory for power lines and terminal boxes to be located within the imme-
diate vicinity of the system and to be easily accessible. Each power line must be
connected to a separate, independent electrical panel and bipolar circuit breaker.
PDUs require an extra cable length of 1.5 meters for connection inside the cabinet.

Electrical Specifications
 (power supplies are auto–sensing and auto–ranging)

Current draw

Power consumption

Thermal dissipation

11 A max. at 200 VAC input

2400 VA per full CSS module

2400 W / 8190 BTU per full CSS module

Europe

Nominal voltage

Voltage range

Frequency

230 VAC (Phase / Neutral)

207 – 244 VAC

50 Hz � 1%

United States of America

Nominal voltage

Voltage range

Frequency

208 VAC (Phase / Neutral)

182 – 229 VAC

60 Hz � 0.3%

Japan

Nominal voltage

Voltage range

Frequency

200 VAC (Phase / Neutral)

188 – 212 VAC

60 Hz � 0.2%

Brazil

Nominal voltage

Voltage range

Frequency

220 VAC (Phase / Neutral)

212 – 231 VAC

60 Hz � 2%

Breaker Protection (Mains Power)

PDU–2–4–M–32A

Maximum inrush current

32A Curve C

210A / per quarter period

Table 10. NovaScale 6165 Server specifications
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B-1Conversion, Keyboard, Writing  Tables

Appendix B. Conversion, Keyboard, and Writing Tables

Imperial to Metric

1 inch (”) 2.54 cm (centimeters)

1 foot (’) (12 inches) 30.48 cm

1 yards (yd) (3 feet) 0.91 m (meters)

1 mile (mi) (1760 yards) 1.6093 km (kilometers)

1 pound (avdp) (lb) 0.5 kg (kilograms)

1 ounce (avdp) (oz) 28.4 g (grams)

1 square foot (ft2) 0.093 m2 (square meters)

1 square inch (in2) 6.5 cm2 (square centimeters)

1 square yard (yd2) 0.8 m2 (square meters)

1 acre 0.4 ha (hectares)

1 cubic foot (ft3) 0.03 m3 (cubic meters)

1 horsepower (hp) 0.7  kw (kilowatts)

1 lb/ft2 4.88 kg/m2

1 Btu 0.2929 w hour

Table 11. Imperial to metric conversion table

Metric to Imperial

1 meter (meter) 3.3’ (feet) / 1.09 yd (yards)

1 centimeter (cm) 0.3937” (inches)

1 kilometer (km) 0.62 mi (miles)

1 gram (g) 0.04 oz (ounces (avdp))

1 kilogram (kg) 2.2 lbs (pounds (avdp))

1 sq. centimeter (cm2) 0.15 in2 (square inches)

1 square meter (m2) 10.76  ft2 (square feet)

1 square meter (m2) 1.2 yd2 (square yards)

1 hectare (ha) 2.5 acres

1 cubic meters (m3) 35.3 ft3 (cubic feet)

1 kilowatts (kW) 1.3 hp (horsepower)

1 kg/m2 0.205 lb/ft2

1 kW hour 3412 Btu (British thermal unit)

Table 12. Metric to imperial conversion table
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Celsius to Fahrenheit Conversion
Multiply the temperature in Celsius by 9, divide by 5 and add 32:
(C� x 9/5) + 32 =  F�

Fahrenheit to Celsius Conversion
Subtract 32 degrees from the temperature in Fahrenheit, multiply by 5 and divide by 9:
(F� – 32) x 5/9 = C�
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AZERTY/QWERTY Keyboard Lookup Table

Figure 63. AZERTY keyboard

Figure 64. QWERTY keyboard
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PAM Writing Rules

Illegal Characters
The following table lists the illegal characters that must not be used in PAM identifiers.

Illegal Characters

à, é, è, ù, ^, ¨ Accentuated letters

/ Slash

\ Backslash

“ Double quote

’ Simple quote

‘ Inverted comma

& Ampersand

+ Plus

* Asterisk

% Percent

= Equal sign

< Less–than sign

> Greater–than sign

: Colon

! Exclamation mark

? Question mark

; Semi–colon

, Comma

~ Tilde

I Pipe operator

Space. Use – (dash) or _ (underscore)

Table 13. PAM illegal characters

String Lengths
The following table lists authorized string lengths.

String Type Length

CellBlock / System Name 16

Scheme Name 32

History Name 64

Archive Name 75 (History Name: + 11 (_JJMMAA_nnn)

LUN Name 32

Switch Name 32

Event Name 32

Description 256 (Scheme: unlimited)

Domain Identity Name 16

Table 14. String length rules
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Registry Keys
PAM obtains file paths via 2 registry keys:

• ReleaseRoot:
Contains PAP application file paths (DLL, WEB pages, models,...).
Two versions of PAM software can be installed and used indifferently on the same
machine: each new version is installed in a new directory.

• SiteRoot:
Contains site data file paths.
Site data remains valid when the PAM software version changes.

Registry keys are generally stored under:
HKEY_LOCAL_MACHINE\SOFTWARE\BULL\PAM
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Glossary

A
AC: Alternating Current generated by the power
supply. See DC.

ACPI: Advanced Configuration and Power

Interface. An industry specification for the efficient
handling of power consumption in desktop and
mobile computers. ACPI specifies how a
computer’s BIOS, operating system, and peripheral
devices communicate with each other about power
usage.

Address: A label, name or number that identifies a
location in a computer memory.

AMI: American Megatrends Incorporated.

ANSI: American National Standards Institute.

API: Application Program Interface. The specific

method prescribed by a computer operating
system or by an application program by which a
programmer writing an application program can
make requests of the operating system or another
application.

Archive: (Archive file). A file that is a copy of a
history file. When a history file is archived, all
messages are removed from the history file.

ASCII: American National Standard Code for
Information Interchange. A standard number

assigned to each of the alphanumeric characters
and keyboard control code keys to enable the
transfer of information between different types of
computers and peripherals.

B
Backup: A copy of data for safe–keeping. The
data is copied form computer memory or disk to a
floppy disk, magnetic tape or other media.

Backup battery: The battery in a computer that
maintains real–time clock and configuration data
when power is removed.

Baud rate: The speed at which data is transmitted
during serial communication.

BERR: Bus Error signal pin used to signal a global

machine check abort condition.

BINIT: Bus Initialization signal pin used to signal a
global fatal machine check condition.

BIOS: Basic Input / Output System. A program
stored in flash EPROM or ROM that controls the
system startup process.

BIST: Built–In Self–Test. See POST.

Bit: Derived from BInary digiT. A bit is the smallest
unit of information a computer handles.

BTU: British Thermal Unit.

Byte: A group of eight binary digits (bit) long that

represents a letter, number, or typographic symbol.

C
Cache Memory: A very fast, limited portion of

RAM set aside for temporary storage of data for
direct access by the microprocessor.

CD-ROM: Compact DisK Read-Only Memory.
High-capacity read-only memory in the form of an
optically readable compact disk.

Cell: The smallest set of hardware components
allocated to a single OS. A cell is functionally
defined by:
– the number of available processors
– memory capacity

– I/O channel capacity.

CellBlock: A group of interconnected cells within a
single domain. See Central Subsystem.

Central Subsystem:  A group of interconnected
cells gathered within a single domain. See
CellBlock.

Chip: Synonym for integrated circuit. See IC.

Clipping: A PAM Event filter criterion. Clipping is
defined on a Count / Time basis aimed at routing a
pre–defined number of messages only. Identical
messages are counted and when the number of
messages indicated in the Count field is reached

within the period of time indicated in the Time field,
no other messages will be selected for routing.

CMC: Corrected Memory Check condition is
signaled when a hardware corrects a machine
check error or when a MCA condition is corrected
by firmware.
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CMCI: Corrected Memory Check Interrupt.

CMCV: Corrected Memory Check Vector.

CMOS: Complementary Metal Oxide
Semiconductor. A type of low–power integrated
circuits. System startup parameters are stored in
CMOS memory. They can be changed via the
system setup utility.

COM: Component Object Model. Microsoft

technology for component based application
development under Windows.

COM +: Component Object Model +.  Microsoft
technology for component based application
development under Windows. The external part of
the PAM software package is a COM+ application.

COM1 or COM2: The name assigned to a serial
port to set or change its address. See Serial Port.

Command: An instruction that directs the
computer to perform a specific operation.

Configuration: The way in which a computer is set
up to operate. Configurable options include CPU

speed, serial port designation, memory allocation,
...

Configuration Tasks: A PAM feature used to
configure and customize the server.

Control Pane: One of the three areas of the PAM
web page. When an item is selected in the PAM
Tree pane, details and related commands are
displayed in the Control pane. See PAM Tree pane
and Status pane.

Core Unit: A main CSS module unit
interconnecting the MIO, MQB, MSX and MFL

boards. See MIO, MQB, MSX, MFL.

COS: Cluster Operating System.

CPE: Corrected Platform Error.

CPEI: Corrected Platform Error Interrupt.

CPU: Central Processing Unit. See
Microprocessor.

CSE: Customer Service Engineer.

CSS: Central Sub–System. See CellBlock.

CSS Module: A MidPlane with all its connected
components (QBBs, IO boards, PMB) and  utility
devices. See Module.

D
D2D: DC to DC converter.

DC: Direct Current generated by the power supply.
See AC.

Default Setting: The factory setting your server
uses unless instructed otherwise.

Density: The capacity of information (bytes) that
can be packed into a storage device.

Device Driver: A software program used by a
computer to recognize and operate hardware.

DIB: Device Interface Board. The DIB provides the
necessary electronics for the Internal Peripheral

Drawer. See IPD.

DIG64: Developer Interface Guide for IA64.

DIM Code: Device Initialization Manager. Initializes
different BUSes during the BIOS POST.

DIMM: Dual In-line Memory Module – the smallest
system memory component.

Disk Drive: A device that stores data on a hard or
floppy disk. A floppy disk drive requires a floppy
disk to be inserted. A hard disk drive has a
permanently encased hard disk.

DMA: Direct Memory Access. Allows data to be
sent directly from a component  (e.g. disk drive) to
the memory on the motherboard). The

microprocessor does not take part in data transfer
enhanced system performance.

DMI: Desktop Management Interface. An industry
framework for managing and keeping track of
hardware and software components in a system of
personal computers from a central location.

DNS: Domain Name Server. A server that retains
the addresses and routing information for TCP/IP
LAN users.

Domain: is the coherent set of resources allocated
to run a customer activity,  i.e. the association –at

boot time– of a Partition, an OS instance (including
applications) and associated LUNs and an
execution context including execution modes and
persistent information (e.g. time, date of the OS
instance). Domain definitions and initializations are
performed via PAM. A Domain can be modified to
run the same OS instance on a different Partition.
When a Domain is running,  its resources are

neither visible nor accessible to other running
Domains.

Domain Identity: a PAM Domain management
logical resource. This resource contains context
information related to the Customer activity running
in a domain. The most visible attribute of this
resource is the name that the Customer gives to
the activity. For each domain created, the Domain
management feature allows the operator to define

a new activity or choose an activity from the list of
existing activities. See Domain.



G-3Glossary

Domain Manager:  A PAM feature used to power
on / off and manage server domains. See Domain.

DPS: Distributed Power Supply.

DRAM: Dynamic Random Access Memory is the
most common type of random access memory
(RAM).

E
ECC: Error Correcting Code.

EEPROM: Electrically Erasable Programmable
Read-Only Memory. A type of memory device that
stores password and configuration data. See also

EPROM.

EFI: Extensible Firmware Interface.

EFIMTA: EFI Modular Test Architecture.

EFI Shell: The EFI (Extensible Firmware Interface)
Shell is a simple, interactive user interface that
allows EFI device drivers to be loaded, EFI
applications to be launched, and operating systems
to be booted. In addition, the EFI Shell provides a
set of basic commands used to manage files and
the system environment variables. See Shell.

EMI: Electro–Magnetic Interference.

EPROM: Erasable Programmable Read-Only
Memory. A type of memory device that is used to

store the system BIOS code. This code is not lost
when the computer is powered off.

ERC: Error and Reset Controller. This controller
allows PAM software to control error detection and
reset propagation within each pre–defined CSS
partition. The ERC is initialized by PAM software to
ensure a partition–contained distribution of the
reset, error, interrupt and event signals; and to
contribute to error signaling and localization at

platform level.

ERP: Error Recovery Procedure.

ESD: ElectroStatic Discharge. An undesirable
discharge of static electricity that can damage
equipment and degrade electrical circuitry.

Event: The generation of a message (event
message) by a software component and that is
directed to the Event Manager.

Event address: Defines the destination for a
message sent over a specified event channel. An
address is one of: the name of a history file (for the
HISTORY channel), an e–mail address (for the

EMAIL channel), the name of a user group (for the
WEB channel), the SNMP Manager IP address (for
the SNMP channel).

Event channel: Defines how the Event Manager
sends an event message. An event channel is one
of: HISTORY (the message is logged in a history
file), EMAIL (the message is sent to an e–mail
address), WEB (the message is stored for analysis
from the PAM web user interface), SNMP (the

message is sent as an SNMP trap to the selected
SNMP application).

Event filter: A list of selected messages among all
possible event messages. If an event message is
not included in the filter, the Event Manager
discards the message.

Event Manager: A PAM feature used to forward
event messages over a configured event channel.
See Event.

Event message: A message sent by a software
component to the Event Manager for routing to a

destination that is configured by an administrator.

Event subscription: An object that defines the
event channel, address, and filter for sending an
event message. If no such object is defined, the
event message is discarded.

Exclusion: Logical removal of a redundant faulty
hardware element until it has been repaired or
replaced. The hardware element remains
physically present in the configuration, but is no
longer detected by PAM software and can no

longer be used by a domain.

External Disk Subsystem: Disk subsystem
housed inside the NovaScale cabinet.

F
Fail–over: Failover is a backup operational mode
in which the functions of a system component
(such as a processor, server, network, or database,
for example) are assumed by secondary system
components when the primary component
becomes unavailable through either failure or
scheduled down time.

FAME: Flexible Architecture for Multiple
Environments.

FAST WIDE: A standard 16–bit SCSI interface

providing synchronous data transfers of up to 10
MHz, with a transfer speed of 20M bytes per
second.

FC: Fibre Channel.

FCAL: Fibre Channel Arbitrated Loop.

FCA: Fibre Channel Adapter.

FCBQ: Fan Control Board for QBB.
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FCBS: Fan Control Board for SPS.

FDA: Fibre Disk Array.

FDD: Floppy Disk Drive.

Flash EPROM: Flash Erasable Programmable
Read-Only Memory. A type of memory device that
is used to store the the system firmware code. This
code can be replaced by an updated code from a
floppy disk, but is not lost when the computer is

powered off.

Firewall:  A set of related programs, located at a
network gateway server, that protects the
resources of a private network from users from
other networks.

Firmware:  an ordered set of instructions and data
stored to be functionally independent of main
storage.

Format: The process used to organize a hard or
floppy disk into sectors so that it can accept data.
Formatting destroys all previous data on the disk.

FPB: FAME Power Board (FAME: Flexible

Architecture for Multiple Environments).

FPGA: Field Programmable Gate Array. A gate
array that can reprogrammed at run time.

FRB: Fault Resilient Boot. A server management
feature. FRB attempts to boot a system using the
alternate processor or DIMM.

FRU: Field Replaceable Unit. A component that is
replaced or added by Customer Service Engineers
as a single entity.

FSS: FAME Scalability Switch. Each CSS Module
is equipped with 2 Scalability Port Switches
providing high speed bi–directional links between

server components. See SPS.

FTP: File Transfer Protocol. A standard Internet
protocol: the simplest way of exchanging files
between computers on the Internet. FTP is an
application protocol that uses Internet TCP/IP
protocols. FTP is commonly used to transfer Web
page files from their creator to the computer that
acts as their server for everyone on the Internet. It
is also commonly used to download programs and

other files from other servers.

FWH: FirmWare Hub.

G
GB: GigaByte: 1,073,741,824 bytes. See Byte.

Global MCA: Machine Check Abort is visible to all
processors, in a multiprocessor system and will
force all of them to enter machine check abort.

GUI: Graphical User Interface.

GTS: Global Telecontrol Server.

H
HA: High Availability. Refers to a system or
component that is continuously operational for a
desirably long length of time.

HAL: Hardware Abstraction Layer.

HA CMP: High Availability Clustered
MultiProcessing.

Hard Disk Drive: HDD. See Disk Drive.

Hardware: The physical parts of a system,

including the keyboard, monitor, disk drives, cables
and circuit cards.

Hardware Monitor:  A PAM feature used to
supervise server operation.

HBA: Host Bus Adapter.

HDD: Hard Disk Drive. See Disk Drive.

History File: A file in which the History Manager
logs informative messages or error messages
relating to system activity. Messages are sent from
source components to target components.

History Manager: The component running on the
PAP Windows operating system that logs
messages to history files.

HMMIO Space: High Memory IO Space.

HPB: Hot Plug Board. This board provides an
interlock switch on each IO Box PCI slot for hot–
swapping PCI boards. See P–HPB.

HPC: High Performance Computing.

Hot plugging: The operation of adding a
component without interrupting system activity.

Hot swapping: The operation of removing and
replacing a faulty component without interrupting
system activity.

HTTP:  HyperText Transfer Protocol. In the World
Wide Web, a protocol that facilitates the transfer of
hypertext–based files between local and remote

systems.
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HW Identifier: Number (0 – F) used to identify
Cellblock components. This number is identical to
PMB code–wheel position.

I
I2C: Intra Integrated Circuit. The I2C (Inter–IC) bus
is a bi–directional two–wire serial bus that provides
a communication link between integrated circuits
(ICs).
The I2C bus supports 7–bit and 10–bit address

space devices and devices that operate under
different voltages.

IA64: is a 64–bit Intel processor Architecture based
on Explicitly Parallel Instruction Computing (EPIC).
The Itanium processor is the first in the Intel line of
IA–64 processors.

IB: Infini Band.

IC: Integrated Circuit. An electronic device that
contains miniaturized circuitry. See Chip.

ICH2: I/O Controller Hub 2, component that
contains the fundamental I/O interfaces required by
the system. Flash memory, Keyboard, USB and

IDE device interface.

ICH4: I/O Controller Hub 4.

ICMB: Intelligent Chassis Management Bus.

ID: A number which uniquely identifies a device on
a bus.

IDE: Integrated Drive Electronics. A type of hard
disk drive with the control circuitry located inside
the disk drive rather than on a drive controller card.

Identity: See Domain Identity.

IIS: Internet Information Server. A group of Internet
servers (including a Web or HTTP server and a
FTP server) with additional capabilities for
Microsoft)  Windows)  NT and Microsoft Windows

(and later) operating systems.

I/O: Input /Output. Describes any operation,
program, or device that transfers data to or from a
computer.

Interface: A connection between a computer and a
peripheral device enabling the exchange of data.
See Parallel Port and Serial Port.

Internal Disk Subsystem: Disk subsystem housed
inside the NovaScale Internal Peripheral Drawer
(IPD).

IOB: Input / Output Board. The IOB connects up to
11 PCI–X boards.

IOC: Input / Output Board Compact. The IOC
connects up to 6 PCI–X boards.

IOL: I/O Board Legacy. The IOL provides:
– I/O controller Hub
– USB ports
– 10/100/1000 Ethernet controller
– Video controller

– Serial / debug port

IOR: I/O Board Riser. The IOR provides:
– I/O controller Hub
– USB ports
– 10/100/1000 Ethernet controller
– Video controller
– Serial / debug port

IP: Internet Protocol. The protocol by which data is
sent from one computer to another via the Internet.
Each computer (known as a host) on the Internet

has at least one IP address that uniquely identifies
it from all other computers on the Internet.

IPD: Internal Peripheral Drawer. The IPD houses
legacy peripherals (DVD–Rom drive, USB port)
and SCSI system disks.

IPF: Itanium Processor Family.

IPL:  Initial Program Load. It defines the firmware
functional phases during the system initialization.

IPMB: Intelligent Platform Management Bus.

IPMI: Intelligent Platform Management Interface.

ISA: Industry Standard Architecture. An industry
standard for computers and circuit cards that
transfer 16 bits of data at a time.

J
Jumper: A small electrical connector used for
configuration on computer hardware.

K
KVM: Keyboard Video Monitor.

KVM switch: the Keyboard Video Monitor switch
allows the use of a single keyboard, monitor and

mouse for more than one module.

L
LAN: Local Area Network. A group of computers

linked together within a limited area to exchange
data.
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LD: Logical Disk. A Storeway FDA 1x00/2x00
logical disk (or LUN) is visible to the OS as a Disk.
See LUN and PD (Physical Disk).

LED: Light Emitting Diode. A small electronic
device that glows when current flows through it.

Legacy Application: An application in which a
company or organization has already invested

considerable time and money. Typically, legacy
applications are database management systems
(DBMSs) running on mainframes or minicomputers.

Licensing Number: When you install an
application protected by a system serial number,
you are requested to supply this serial number.For
optimum flexibility, PAM software allows you to
replace the physical serial number by a logical
licensing number so that you can run the
application on any physical partition and, in the

case of extended systems, on any of the Central
Subsystems within the extended configuration.

LID: Local Interrupt Identifier (CPU).

Local Disk Subsystem: Disk subsystem housed
inside the NovaScale cabinet and not connected to
a SAN.

Local MCA: Machine Check Abort is detected and
handled by a single processor and is invisible to
the other processor.

Locking: Means of functionally limiting access to
certain hardware elements. Locked hardware

elements can no longer be accessed by the current
domain, but are still physically available for use by
other domains. Previously locked elements can be
unlocked so that they can be accessed by the
domain.

LPT1 or LPT2: The name assigned to a parallel
port to specify its address. See Parallel Port.

LS240: Laser Servo super diskette holding up to
240 Mb.

LUN: Logical Unit Number. Term used to designate
Logical Storage Units (logical disks) defined

through the configuration of physical disks stored in
a mass storage cabinet.

LVDS: Low Voltage Differential SCSI.

M
MAESTRO: Machine Administration Embedded
Software Real Time Oriented. 
Part of the PAM software package embedded on
the PMB board.

MCA: Machine Check Abort. 
See also Local MCA and Global MCA.

Memory: Computer circuitry that stores data and
programs. See RAM and ROM.

Memory bank: The minimum quantity of memory
used by the system. It physically consists of four
memory DIMMs.

MFL: Midplane Fan & Logistics board. The MFL
houses the Fan Boxes and is connected to the MIO

and MQB. See MIO, MQB.

Microprocessor: An integrated circuit that
processes data and controls basic computer
functions.

Midplane: Mid–Plane. All system hardware
components are connected to the Midplane.

MIMD: Multiple Instruction Multiple Data

MIO: Midplane Input / Output board. The MIO
connects one or two IOC boards and the PMB. See
Core Unit.

Mirrored volumes: A mirrored volume is a
fault–tolerant volume that duplicates your data on
two physical disks. If one of the physical disks fails,

the data on the failed disk becomes unavailable,
but the system continues to operate using the
unaffected disk.

Module: a Midplane Board with all its connected
components and utility devices. See CSS Module
and MP.

MQB: Midplane QBB board. The MQB connects
one or two QBBs and one or two IPDs. See QBB
and IPD.

MSX: Midplane SPS & XPS board. The MSX
houses a B–SPS switch and is connected to the

MIO and the MQB. There are two MSX boards in a
CSS module. All SP connections between a QBB
and an IOC use an MSX. See B–SPS, MIO, MQB.

MTBF: Mean Time Between Failure. An indicator
of expected system reliability calculated on a
statistical basis from the known failure rates of
various components of the system. Note: MTBF is
usually expressed in hours.

Multimedia: Information presented through more
than one type of media. On computer systems, this

media includes sound, graphics, animation and
text.

Multitasking: The ability to perform several tasks
simultaneously. Multitasking allows you to run
multiple applications at the same time and
exchange information among them. See Task.
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Multithreading: The ability to manage more than
one user/program or multiple requests by the same
user/program at a time without running multiple
copies of an application. Each user/program
request is kept track of as a thread. See Thread.

N
NFS: Network File System. A proprietary
distributed file system that is widely used by
TCP/IP vendors. Note: NFS allows different

computer systems to share files, and uses user
datagram protocol (UDP) for data transfer.

NMI: Non–Maskable Interrupt.

NUMA: Non Uniform Memory Access. A method of
configuring a cluster of microprocessors in a
multiprocessing system so that they can share
memory locally, improving performance and the
ability of the system to be expanded.

nsh: nsh stands for new shell. See Shell and EFI
Shell.

NVRAM:  Non Volatile Random Access Memory. A
type of RAM that retains its contents even when

the computer is powered off. See RAM and SRAM.

O
OF:  Open Firmware. Firmware controlling a

computer prior to the Operating System.

Operating System: See OS.

OS: Operating System. The software which
manages computer resources and provides the
operating environment for application programs.

P
PAL: Processor Abstraction Layer: processor
firmware that abstracts processor implementation
differences. See also SAL.

PAM: Platform Administration & Maintenance.

PAM software: Platform Administration &
Maintenance software. One part (PAP application
and the PamSite WEB site) runs on the PAP unit.
The other part (MAESTRO) is embedded on the
PMB board.

PAM Tree pane: One of the three areas of the

PAM web page. Server hardware presence and
functional status are displayed in the PAM Tree
pane. See Status pane and Control pane.

PAP unit: Platform Administration Processor unit.
The PC hosting all server administration software.

PAP application: Platform Administration
Processor application. Part of PAM software, PAP
application is a Windows COM+ application
running on PAP unit.

Parallel Port: Connector allowing the transfer of

data between the computer and a parallel device.

PARM request:  the PARM application is designed
to handle Requests issued by the CSE (Customer
Service Engineer)

Partition: Division of storage space on a hard disk
into separate areas so that the operating system
treats them as separate disk drives.

Password: A security feature that prevents an
unauthorized user from operating the system.

PCI: Peripheral Component Interconnect. Bus
architecture supporting high-performance
peripherals.

PD: Physical Disk. A Storeway FDA 1300/2300

physical disk is not visible to the OS. See LD.

PDU: Power Distribution Unit. Power bus used for
the connection of peripheral system components.

Permanence: Property of a history file that
determines whether or not the history file can be
modified or deleted from the PAM user interface.
Permanence is either Static (cannot be modified) or
Dynamic (can be modified).

P–HPB: PCI Hot Plug Board. This board provides
an interlock switch on each IO Box PCI slot for
hot–swapping PCI boards. See HPB.

PIC: Platform Instrumentation Control.

ping: A basic Internet program that lets you verify

that a particular IP address exists and can accept
requests. The verb “to ping” means the act of using
the ping utility or command.

PIROM: Processor Information ROM. Processor
Information ROM (PIROM) contains information
about the specific processor in which it resides.
This information includes robust addressing
headers to allow for flexible programming and
forward compatibility, core and L2 cache electrical

specifications, processor part and S–spec
numbers, and a 64–bit processor number.

PMB: Platform Management Board. Links the
server to the PAP unit.
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PNP: Plug aNd Play. The ability to plug a device
into a computer and have the computer recognize
that the device is there.

POST: Power On Self Test. When power is turned
on, POST (Power–On Self–Test) is the diagnostic
testing sequence (or “starting program”) that a
computer runs to determine if hardware is working

correctly.

PROM: Programmable Read-Only Memory.

PUID:  PAM Universal/Unique IDentifier. PAM
software allocates a PUID (PAM Universal / Unique
Identifier) to each hardware / software object to
guarantee unambiguous identification. 
The PUID for each hardware element can be
obtained by hovering the mouse over the
corresponding element in the PAM tree,  e.g.:
PAM:/CELLSBLOCK_<NAME>/MODULE_x/QBB_

y/CPU_y.

Q
QBB: Quad Brick Board. The QBB is the heart of

the Bull NovaScale Server, housing 4 Itanium � 2
processors and 16 DIMMs. Each QBB
communicates with other CSS Module components
via 2 high–speed bidirectional Scalability Port
Switches. 
See SPS or FSS.

R
RAID: Redundant Array of Independent Disks. A
method of combining hard disk drives into one
logical storage unit for disk-fault tolerance.

RAM: Random Access Memory. A temporary
storage area for data and programs. This type of

memory must be periodically refreshed to maintain
valid data and is lost when the computer is
powered off. See NVRAM and SRAM.

RAS: Reliability, Availability, Serviceability.

Real–time clock: The Integrated Circuit in a
computer that maintains the time and date.

RFI: Radio Frequency Interference.

RJ45: 8–contact regular jack.

RMC: Remote Maintenance Console.

ROM: Read-Only Memory. A type of memory
device that is used to store the system BIOS code.
This code cannot be altered and is not lost when
the computer is powered off. See BIOS, EPROM
and Flash EPROM.

RS-232 Port: An industry standard serial port. See
Serial Port.

RSF: Remote Service Facilities.

RTC: Real Time Clock.

S
S@N.IT: SAN Administration Tool.

SAL: System Abstraction Layer. Firmware that
abstract system implementation differences in
IA–64 platform. See also PAL.

SAN: Storage Area Network. A high–speed
special–purpose network that interconnects
different kinds of data storage devices with

associated data servers on behalf of a larger
network of users.

SAPIC: Streamlined Advanced Programmable
Interrupt Controller message.

SBE: Single Bit Error.

Scheme: Configuration file ensuring optimum use
and compatibility of the physical and logical
resources used to simultaneously run multiple
domains.

SCI: Scalable Coherent Interface.

SCSI: Small Computer System Interface. An input
and output bus that provides a standard interface
used to connect peripherals such as disks or tape

drives in a daisy chain.

SDR: Sensor Data Record.

SDRAM: Synchronous Dynamic Random Access
Memory. A type of DRAM that runs at faster clock
speeds than conventional memory. See DRAM.

SEL: System Event Log. A record of system
management events. The information stored
includes the name of the event, the date and time
the event occurred and event data. Event data may
include POST error codes that reflect hardware
errors or software conflicts within the system.

Serial Communication: Data sent sequentially,

one bit at a time.

Serial Port: Connector that allows the transfer of
data between the computer and a serial device.
See COM1 or COM 2.Shell is a Unix term for the
interactive user interface with an operating system.

SIO: Server I/O / Super I/O.
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Shell: The Shell is the layer of programming that
understands and executes the commands a user
enters. As the outer layer of an operating system,
the Shell can be contrasted with the kernel, the
inmost layer or core of services of an operating
system. See EFI Shell.

SIOH: Server I/O Hub. This component provides a

connection point between various I/O bridge
components and the Intel 870 chipset.

SMBIOS: System Management BIOS.

SM–BUS: System Management Bus.

SMIC: Server Management Interface Chip.

SMP: Symmetrical Multi Processor. The processing
of programs by multiple processors that share a
common operating system and memory.

SNC: Scalable Node Controller. The processor
system bus interface and memory controller for the
Intel870 chipset. The SNC supports both the
Itanium2 processors, DDR SDRAM main memory,

a Firmware Hub Interface to support multiple
Firmware hubs, and two scalability ports for access
to I/O and coherent memory on other nodes,
through the FSS.

SNM: System Network Module.

SNMP: Simple Network Management Protocol.
The protocol governing network management and
the  monitoring of network devices and their
functions.

Source: Each message refers to a source (the
resource that generated the message) and a target

(the component referred to in the message). This
feature can be allows messages to be filtered
according to one or more Source string(s) and is
particularly useful for debugging and
troubleshooting. See Target.

SPD: Serial Presence Detect. DIMM PROM.

SPS: Scalability Port Switch. Each CSS Module is
equipped with 2 Scalability Port Switches providing
high speed bi–directional links between system
components. See FSS.

SRAM: Static RAM.  A temporary storage area for

data and programs. This type of memory does not
need to be refreshed, but is lost when the system is
powered off. See NVRAM and RAM.

SSI: Server System Infrastructure.

Status Pane: One of the three areas of the PAM
web page. Provides quick access to CSS Module
availability status, server functional status, and
pending event message information. See also
Control pane and PAM Tree pane.

SVGA: Super Video Graphics Array.

T
Target:  Each message refers to a target (the
component referred to in the message), identified

by its PUID, and a source (the component that
generated the message).This feature allows
messages to be filtered according to one or more
Target string(s) and is particularly useful for
debugging and troubleshooting. See Source and
PUID.

Task: Each message refers to a target (the
component referred to in the message), identified
by its PUID, and a source (the component that

generated the message).This feature allows
messages to be filtered according to one or more
Target string(s) and is particularly useful for
debugging and troubleshooting. See Source and
PUID.

TCP: Transmission Control Protocol. A set of rules
(protocol) used along with the Internet Protocol (IP)
to send data in the form of message units between
computers over the Internet.

TCP/IP: Transmission Control Protocol / Internet

Protocol. The basic communication language or
protocol of the Internet.

T&D: Tests and Diagnostics.

Thresholding: A PAM Event filter criterion.
Thresholding is defined on a Count / Time basis
aimed at routing significant messages only.
Identical messages are counted and when the
number of messages indicated in the Count field is
reached within the period of time indicated in the
Time field, this message is selected for routing.

U
UART: a Universal Asynchronous Receiver
Transmitter. The microchip with programming that

controls a computer interface to its attached serial
devices.

ULTRA SCSI: An enhanced standard 16–bit SCSI
interface providing synchronous data transfers of
up to 20 MHz, with a transfer speed of 40M bytes
per second. It is also called Fast-20 SCSI.

UML: Unified Modeling Language. A standard
notation for the modeling of real–world objects as a
first step in developing an object–oriented design
methodology.

UPS: Uninterruptible Power Supply. A device that

allows uninterrupted operation if the primary power
source is lost. It also provides protection from
power surges.
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URL: Uniform / Universal Resource Locator. The
address of a file (resource) accessible on the
Internet.

USB: Universal Serial Bus. A plug–and–play
interface between a computer and add–on devices.
The USB interface allows a new device to be
added to your computer without having to add an

adapter card or even having to turn the computer
off.

V
VCC: Voltage Continuous Current.

VGA: Video Graphics Array.

VI: Virtual Interface.

Visibility: A property of a history file. Visibility is
either System (the history file is predefined by the
PAM software and is visible only to an
administrator) or User (the history file is created by
an administrator and is visible to both an
administrator and an operator).

VLAN: Virtual Local Area Network. A local area
network with a definition that maps workstations on

some other basis than geographic location (for
example, by department, type of user, or primary
application).

VxWORKS: Platform Management Board
Operating System.

W
WAN: Wide Area Network. Geographically
dispersed telecommunications network. The term

distinguishes a broader telecommunication
structure from a local area network (LAN).

WBEM: Web Based Enterprise Management.

WMI: Windows Management Interface.

WOL: A feature that provides the ability to remotely
power on a system through a network connection.

X
XML: eXtended MarkUp Language. A flexible way
to create common information formats and share
both the format and the data on the World Wide
Web, intranets, and elsewhere.

XSP: eXtended Scalable Port.

Y
No entries.

Z
No entries.
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A
Access, front door, 2-2
Autocalls

configuring, 2-34
FTP parameters, 2-34
testing, 2-57

B
Back Up, PAM software, 2-69

C
Cabinet, unpacking, 1-8
Cabling, inter–cabinet, 2-5
CD–ROM drive, 1-17
Central Subsystem

configuring, 2-58
removing, 2-58

Central subsystem, adding, 2-58
Checks

autocall connection, 2-57
network connections, 2-57
server operation, 2-7
server status, 2-10

Components
5085, 1-12
6085, 1-14

Connecting, external devices, 2-56
Connections

Enterprise LAN, 2-36, 2-55
network, 2-57
PAP unit, 2-36

Console, 1-18
opening / closing, 2-3
toggling, 2-13

CSS Module, PMB, 2-4
CSS module, 1-16

availability status, 2-11
shipping brackets, 1-9
stoppers, 1-9

Customer information, configuring, 2-33

D
Delivery

server, 1-7
system, 1-2

Details pane, PAM, 2-10
Devices, external, 2-56
DIMMs, 1-16
Disk racks, setup, 2-53
Disks, 1-17
Domain

power down, 2-14, 2-16
power up, 2-14, 2-16

DVD/CD–ROM drive, 1-16

E
Electrical safety, xv
Electromagnetic compatibility, xvii
Electrostatic discharges, xviii
Enterprise LAN

connecting PAP unit, 2-36
connection, 2-55

Environmental standards, xvii
Ethernet hub, 1-23
Ethernet ports, 1-16, 1-17

F
FC storage subystems, password, changing, 2-26
FDA 1300 disk rack, 1-21
FDA 2300 FC disk rack, 1-21
FDD, 1-17
Front door, opening, 2-2

G
Getting to know, server, 1-12

I
Illegal characters, B-4
Inspecting, server, 1-8
Inspection

cabling, 1-11
components, 1-11

Installation
flowchart, xx
intervention report, 2-57

Intervention report, installation, 2-57
IOB, 1-16
IOL, 1-16

K
Keyboard, 1-18
Keys, registry, B-5
KVM switch, 1-19

L
Laser safety, xvi
Limits

audio–noise, xix
pollution, xix

M
Memory boards, 1-16
Modem, 1-23
Monitor, 1-18
Mother boards, 1-16
Mouse, 1-18

N
Network, testing, 2-57
Notices

electrical safety, xv
laser safety, xvi
safety, xv

NPort Server, 1-23

O
Operating System, completing setup, 2-39
Operating system, setup

completing, 2-40, 2-44, 2-48
Microsoft Windows, 2-41, 2-45, 2-49
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P
PAM

details pane, 2-10
status pane, 2-10
toolbar, 2-12
user interface, 2-9
writing rules, B-4

PAM software
back up / restore, 2-69
launching, 2-7

PAM tree pane, 2-11
PAP unit, 1-17

CD–ROM drive, 1-17
configuration, 2-28
disks, 1-17
Ethernet ports, 1-17
FDD, 1-17
serial ports, 1-17

PAP users, setting up, 2-67
Password, changing, FC storage subsystems, 2-26
Peripheral drawer, 1-16
PHPB, 1-16
PMB, 1-16

code wheels, 2-4
Power cables, 1-17, 1-18, 1-19, 1-20, 1-21, 1-22
Power down, server domain, 2-14, 2-16
Power supply, connecting, 2-5
Power–up

server, 2-6
server domain, 2-14, 2-16
system domains, 2-21

Processors, 1-16
Program, post–install, 2-28
PUID, PAM software, 2-7

Q
QBBs, 1-16

R
RAID controller, 1-20
Remote access

iSM, 2-38
PAM, 2-37

Restarting, server, 2-15, 2-20, 2-25
Restoring, PAM software, 2-69

S
S@NIT, password, changing, 2-27
Safety

notices, xv
recommendations, 2-5
specifications, xix

SCSI JBOD rack, 1-20
SCSI rack, 1-20
Serial ports, 1-16, 1-17
Server

configuring, 2-58
domain, 2-14, 2-16
getting to know, 1-12
inspecting, 1-8
restarting, 2-15, 2-20, 2-25
shutdown, 2-15, 2-20, 2-25

Server components
accessing, 2-2
CD–ROM drive, 1-17
console, 1-18
core unit, 1-16
CSS module, 1-16
DIMMs, 1-16
Ethernet hub, 1-23
Ethernet ports, 1-16, 1-17
FDA 1300 FC, 1-21
FDA 2300 FC, 1-21
FDD, 1-17
internal peripheral drawer, 1-16
IOB, 1-16
IOL, 1-16
keyboard, 1-18
KVM switch, 1-19
memory boards, 1-16
modem, 1-23
monitor, 1-18
mother boards, 1-16
mouse, 1-18
NPort Server, 1-23
PAP unit, 1-17
PAP unit disks, 1-17
PHPB, 1-16
PMB, 1-16, 2-4
power cables, 1-17, 1-18, 1-19, 1-20, 1-21,

1-22
processors, 1-16
QBBs, 1-16
RAID controller, 1-20
SCSI JBOD rack, 1-20
SCSI rack, 1-20
serial ports, 1-16, 1-17
USB ports, 1-16
VGA port, 1-16

Server operation, checking, 2-7
Server status, checking, 2-10
Setting up, PAP users, 2-67
Setup

Microsoft Windows, 2-41, 2-45, 2-49
operating system, completing, 2-40, 2-44, 2-48
preparing disk racks, 2-53

Shipping brackets, CSS module, 1-9
Shocks and vibrations, xviii
Shutdown, server, 2-15, 2-20, 2-25
Specifications

atmospheric, xvii
electrical, xvii
NovaScale 5085 Servers, A-2
NovaScale 5165 Server, A-4
NovaScale 6085 Server, A-6
NovaScale 6165 Server, A-8
safety, xix
system, A-1

Status, CSS module, 2-11
Status pane, PAM, 2-10
Stoppers, CSS module, 1-9
Storage area network, S@NIT, password, 2-27
String lengths, B-4
System

dimensions, A-1
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domains, 2-21
weight, A-1

System components, DVD/CD–ROM drive, 1-16

T
Toolbar, PAM, 2-12

U
USB modem, connecting, 2-56
USB ports, 1-16

User group, PAP, 2-67
User interface, PAM, 2-9

V
VGA port, 1-16

W
Writing rules

illegal characters, B-4
string lengths, B-4
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	Site Preparation Guide, 86 A1 87EF explains how to prepare a Data Processing Center for Bull NovaScale Servers, in compliance with the standards in force. This guide is intended for use by all personnel and trade representatives involved in the site preparation process. User's Guide, 86 A1 41EM explains how to use NovaScale 5xx5/6xx5 Servers. This guide is intended for use by Customer Administrators and Operators. Maintenance and Service Guide, 86 A7 42EM explains how to maintain, service, and upgrade NovaScale 5xx5/6xx5 Servers. This guide is intended for use by qualified support personnel. Troubleshooting Guide, 86 A7 91EF explains how to diagnose and solve any problems occurring during Bull NovaScale Server operation. This guide is intended for use by qualified support personnel. NovaScale 5000/6000 Series PAM Help Message Guide, 86 A7 32ER provides the complete collection of PAM Help Messages containing valuable troubleshooting information. This guide is intended for use by qualified support personnel. NovaScale 5000/6000 Series Praxidiag Diagnostics Guide, 86 A7 33ER provides the complete collection solutions to known problems extracted from the Praxidiag database. This guide is intended for use by qualified support personnel. NovaScale 5000/6000 Series Cabling Guide, 86 A1 34ER describes server cabling. Bull 1300H/L & 1100H/L Cabinets, 86 A1 91EM explains how to install and fit out rack cabinets for Bull NovaScale Servers and peripheral devices. Documentation Overview, 86 A2 27EM describes the hardware, software and online documentation available for Bull NovaScale Servers, related Operating Systems, and licensed programs. Note: According to server configuration and version, certain features and functions described in this guide may not be accessible. Please contact your Bull Sales Representative for sales information.

	We hereby certify that this product is in compliance with European Union EMC Directive 89/336/EEC, using standards EN55022 (Class A) and EN55024 and Low Voltage Directive 73/23/EEC, using standard EN60950. The product has been marked with the CE Mark to illustrate its compliance. Safety Compliance Statement . (USA) . (International) . (Canada) Directives Council Directives: Electromagnetic Compatibility . 89/336/EEC Low Voltage . 73/23/EEC EC Conformity . 93/68/EEC Telecommunications Terminal Equipment . 1999/5/EC Neither the provider nor the manufacturer can accept responsibility for any failure to satisfy the protection requirements resulting from a non-recommended modification of the product. Compliance with these directives requires: . an EC declaration of conformity from the manufacturer . an EC label on the product . technical documentation
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